LENESAS Release Note

e? studio 2023-07 (2023-07.R20230714-1443) R20UT5328EG0100

Rev.1.00
Release Note 20th July 2023
Introduction

This document outlines the device support, new features added in 2023-07, fixed issues and open issues in e? studio
2023-07.
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1. Product Information
1.1 Supported Operating Systems
These operating systems are officially supported by e? studio:
e Windows 10 64-bit
e  Windows 11 64-bit
In addition, another official product build is available for Linux. This version supports:
e Ubuntu 20.04 LTS
e Ubuntu22.04 LTS

No other Linux distributions are officially supported by e? studio.

¢? studio now runs on Java 17 & does not support older Java versions.

111 Windows 64-bit product version

Please note that 2020-04 and later versions are 64-bit product build versions of the tool.

We would like to state that the workspaces and projects from 7.x versions (32-bit) of e? studio are compatible with 64-
bit e* studio.

When opening a workspace from 7.x you will be shown a warning, and this is standard Eclipse behavior. This is shown
because some metadata in the workspace can change between versions so a workspace will not always work with older
versions of the tool.

- Projects are forward & backward compatible,
- Workspaces work when upgrading but it is not guaranteed to 100% work if you return the workspace to 7.8.

The switch to 64-bit has unfortunately meant that some functions have now been deprecated from the tooling due to this
move for the base platform. The removed functionality is listed below:

HEW Project Convertor
e Renesas RTOS views
e  Mylyn integration
e Subversion integration
If you need this functionality, then please remain on e? studio 7.8.

Linux tools are now only available in the Linux host version of e? studio.

1.1.2 System requirements
For Windows 64-bit version

e  System: x64 based processor, 2 GHz or faster, CPU has dual cores or more
o  Windows® 11 (64-bit version)
o Windows® 10 (64-bit version)

Memory capacity: We recommend 8 GB or more. At least 4 GB.

Capacity of hard disk: At least 2 GB of free space.

e Display: Graphics resolution should be at least 1024 x 768, and the mode should display at least 65,536 colors.
e Interface: USB 2.0
e  Microsoft Visual C++ 2010 SP1 runtime library *!
e Microsoft Visual C++ 2015-2019 runtime library *!
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*1. This software will be installed at the same time as the e? studio.
For Linux

e  System: x64 based processor, 2 GHz or faster, CPU has dual cores or more
o Ubuntu 20.04 LTS Desktop (64-bit version)
o Ubuntu 22.04 LTS Desktop (64-bit version)

e Memory capacity: We recommend 2 GB or more.

e Capacity of hard disk: At least 2 GB of free space.

R20UT5328EG0100  Rev.1.00
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1.1.3 Linux version

The Linux product version of e? studio for Linux is based on the same content as the Windows release.

Therefore, documents of e? studio will be helpful for common usages. There are some differences, the Linux version
only supports some different levels of tooling.

The Linux product supports RX, RL78, RH850, RA, RZ and DA.
Synergy and RE are not supported under Linux host OS.

RX, RH850, RL78 are added in 2023-01 for the first time for Linux host OS. The feature set for these families are
reduced under Linux.

e RX: Toolchain support only GCC, debug support E2/E2 Lite Emulator and Segger J-link. No Renesas
simulator support.

e RL78: Toolchain support only GCC and LLVM, debug support for E2/E2 Lite Emulator. No Renesas
simulator support.

e RHS850: No toolchain support apart from Green Hills and IAR. Debug support for E2 Emulator.

The Code Generator is not supported under the Linux host OS.

For information on how to install the Linux product please refer to FAQ in below URL.

English: https://en-support.renesas.com/knowledgeBase/19934358
Japanese: https://ja-support.renesas.com/knowledgeBase/19934356

Device Family Windows Product Support Linux Product Support
EC-1 Yes No
RA Yes Yes
RE Yes No
RH850 Yes Yes
RL78 Yes Yes
RX Yes Yes
Rz Yes Yes
(No RZ/G Linux Platform Tools)
Synergy Yes No
DA Yes Yes
R20UT5328EG0100 Rev.1.00 Page 5 of 61
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1.2 Supported Toolchains — Windows Hosted

The following toolchains are supported in e? studio.

Renesas GNU Arm Renesas GCC/ IAR (*4) Green Hills
Embedded (*2) GNURZ/ARM (*3) (*5)
RL78 Yes (CC-RL) No Yes Yes No
% RX Yes (CC-RX) No Yes Yes No
% RH850 Yes (CC-RH) No No Yes Yes
E: RZ/ARM No No (*1) Yes Yes No
Synergy/ARM No Yes No Yes No
RA/ARM No Yes No Yes No
RE/ARM No Yes No Yes No
Note:

*1: Project converter is available to convert from GNUARM RZ/none to GNU ARM Embedded toolchain.

*2: The GCC toolchains for RZ Family and Renesas Synergy™ are distributed via
Arm Developer at https://developer.arm.com/open-source/gnu-toolchain/gnu-rm

or Launchpad.net at: https://launchpad.net/gcc-arm-embedded. They are also available using the

“Additional components” page in the e? studio installer. Supported ARM GCC versions vary from device

family to device family. Please see the following table for more information:

*3: Legacy GNUARM toolchains are available from https://llvm-gcc-renesas.com/. In addition, the latest
RX and RL78 Renesas GCC toolchains are available from this website.
Also LLVM for RL78 is available from https://llvm-gcc-renesas.com/ .

*4: The IAR toolchain plugins are available via the “Help”->”" IAR Embedded Workbench plugin manager”
menu in e? studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.

*5: The Green Hills toolchain plugins are available within the e? studio product. These plugins are provided
by Green Hills and are not supported by Renesas.

R20UT5328EG0100  Rev.1.00
20th July 2023
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Device Family

GCC distribution and version

RZ/A1, A2

9.3.1 (2020 g2)

RZ/A3UL

FSP 1.0.0: AArch64 bare-metal 10.3.2021.07
FSP 1.1.0: AArch64 bare-metal 10.3.2021.07
FSP 1.2.0: AArch64 bare-metal 10.3.2021.07
FSP 1.2.1: AArch64 bare-metal 10.3.2021.07
FSP 2.0.0: AArch64 bare-metal 10.3.2021.07

RZ/G1, G2 (Cortex-A)

Linaro 7.4.1

RZ/G2L (Cortex-M33)

FSP 1.0.0: 9.2.1(2019q4)
FSP 1.1.0: 9.2.1(2019q4)
FSP 1.2.0: 9.2.1(2019q4)

RZ/N2L

FSP 1.0.0: 9.3.1(2020q2)
FSP 1.1.0: 9.3.1(2020q2)
FSP 1.2.0: 9.3.1(2020q2)

RZ/T2M

FSP 1.0.0: 9.3.1(2020q2)
FSP 1.1.0: 9.3.1(2020q2)
FSP 1.2.0: 9.3.1(2020q2)

RZ/T2L

FSP 1.2.0: 9.3.1(2020q2)

RZ/NV2L

FSP 1.0.0: 9.2.1(2019q4)
FSP 1.1.0: 9.2.1(2019q4)

Synergy

SSP 1.6.x:7.2.1

SSP1.7.x:7.2.1
SSP2.0,21,22<->22:921and 7.2.1
SSP 2.3, 2.4: 10.3-2021.10

RA

FSP 3.5.0: 10.3-2021.10
FSP 3.6.0: 10.3-2021.10
FSP 3.7.0: 10.3-2021.10
FSP 3.8.0: 10.3-2021.10
FSP 3.9.0: 10.3-2021.10
FSP 4.0.0: 10.3-2021.10
FSP 4.1.0: 10.3-2021.10
FSP 4.2.0: 10.3-2021.10
FSP 4.3.0: 10.3-2021.10
FSP 4.4.0: 10.3-2021.10
FSP 4.5.0: 10.3-2021.10

RE

RE SDK 1.1.0: 6.3.1(2017 q2)

R20UT5328EG0100  Rev.1.00
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1.3 Supported Toolchains — Linux Hosted

The following toolchains are supported in e? studio:

e Linaro GCC — tested version 7.3.1-201805

e GNU Arm Embedded — tested version 7.3.1.2018.06022

e GNU Tools for ARM Embedded Processors for RA 9.3.1.20200408 (2020-q2-update)
e GNU Tools for ARM Embedded Processors for RA 10.3-2021.10

e GCC for Renesas 8.3.0.202204-GNURX Linux Toolchain (ELF)

e LLVM for Renesas RL78 10.0.0.202301 Linux Toolchain (ELF Format)

R20UT5328EG0100  Rev.1.00 Page 8 of 61
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2. Device Support

21 Project Generator Support

Note: The Renesas SH device family is no longer supported in € studio.

Family Group Devices
DA1459x DA14595,(Debug Support Only)
DA1469x DA14691, DA14695, DA14697, DA14699,(Debug Support Only)
DA DA1470x DA14701, DA14705, DA14706, DA14708,(Debug Support Only)
DA16200 DA16200,(Debug Support Only)
DA16600 DA16600,(Debug Support Only)
EC-1 EC-1 R9A06G043
RA2 R7FA2A1AB, R7TFA2E1A5, R7TFA2E1A7, R7TFA2E1A8, R7TFA2E1A9,
R7FA2E2A3, R7TFA2E2A5, R7TFA2E2A7, R7TFA2L1A9, R7TFA2L1AB
R7FA4E10B, R7FA4E10D, R7FA4E2B9, R7FA4M1AB, R7FA4M2AB,
RA4 R7FA4M2AC, R7TFA4M2AD, R7FA4M3AD, R7FA4M3AE,
R7FA4M3AF, R7TFA4T1B9, R7TFA4T1BB, R7TFA4W1AD
RA R7FA6E10D, R7FAGE10F, R7TFAGE2B9, R7TFAGE2BB, R7TFA6M1AD,
R7FA6M2AD, R7TFA6M2AF, R7TFA6M3AF, R7TFA6M3AH,
RAG R7FA6M4AD, R7TFABM4AE, R7TFABM4AF, R7TFA6M5AG,
R7FA6M5AH, R7TFA6M5BF, R7TFA6M5BG, R7FA6M5BH,
R7FA6T1AB, R7TFA6T1AD, R7FA6T2AB, R7TFA6T2AD, R7FA6T2BB,
R7FA6T2BD, R7TFA6T3BB
REO1B R7FOEQ1BD2DNB
RE01 1500KB R7FOE014D2CFB, R7FOE014D2CFP, R7FOE015D2CFB,
RE B R7FOEQ15D2CFP, R7FOEQ16D2DBN, R7FOE017D2DBN
R7FOE01082CFM, R7FOE01082CFP, R7FOE01082DBH,
REO1 256KB R7FOE01082DBR, R7FOE01082DNG, R7FOE01182CFM,
= R7FOE01182CFP, R7FOE01182DBH, R7FOE01182DBR,
R7FOE01182DNG
C1H R7F701260, R7F701270
C1M R7F701263, R7F701271
C1M-A1 R7F701278
C1M-A2 R7F701275
D1L1 R7F701401, R7F701421
D1L2 R7F701402, R7F701422
D1M1 R7F701404, R7F701405
D1M1-V2 R7F701442, R7F701462
RH850 D1M2 R7F701408, R7F701410, R7F701428, R7F701430
E1L R7F701201, R7F701205
E1M-S R7F701202, R7F701204
E1M-S2 R7F701215, R7F701216
- R7F701205, R7F701206, R7F701207
R7F701501, R7F701502, R7F701503, R7F701506, R7F701507,
F1H R7F701508, R7F701511, R7F701512, R7F701513, R7F701526,
R7F701527, R7F701528, R7F701529, R7F701530, R7F701531,
R7F701534
- R7F701521, R7F701522, R7F701524, R7F701525
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R7F701542, R7F701543, R7F701546, R7F701547, R7TF701557,
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566,

F1K R7F701567, R7F701577, R7F701580, R7F701581, R7F701582,
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602,
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613,
R7F701620, R7F701621, R7F701622, R7F701623

F1KH R7F701708, R7F701709, R7F701710, R7F701711, R7F701714,
R7F701715

R7F701644, R7F701645, R7F701646, R7F701647, R7F701648,
R7F701649, R7F701650, R7F701651, R7F701652, R7F701653,

F1KM R7F701684, R7F701685, R7F701686, R7F701687, R7F701688,
R7F701689, R7F701690, R7F701691, R7F701692, R7F701693,
R7F701694, R7F701695, R7F701760, R7F701762, R7TF701764,
R7F701A55, R7F701A56, R7F701A57, R7F701A58, R7F701A59,
R7F701A60

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP,
R7F701007xAFP, R7F701008xAFP, R7F701009xAFP,
R7F701010xAFP, R7F701011xAFP, R7F701012xAFP,
R7F701013xAFP, R7TF701014xAFP, R7F701015xAFP,
R7F701016xAFP, R7TF701017xAFP, R7F701018xAFP,
R7F701019xAFP, R7TF701020xAFP, R7F701021xAFP,
R7F701022xAFP, R7F701023xAFP, R7F701024xAFP,
R7F701025xAFP, R7F701026xAFP, R7F701027xAFP,
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP,
R7F701032xAFP, R7F701033xAFP, R7F701034xAFP, R7F701040,
R7F701041, R7F701042, R7F701043, R7F701044, R7F701045,
R7F701046, R7F701047, R7F701048, R7F701049, R7F701050,
R7F701051, R7F701052, R7F701053, R7F701054, R7F701055,
R7F701056, R7F701057

F1L

R7F701544, R7F701545, R7F701548, R7F701549, R7F701552,
FIM R7F701553, R7F701564, R7F701565, R7F701568, R7F701569,
R7F701572, R7F701573

P1H-C R7F701370AEEBG, R7F701371EABG, R7F701372EABG,
R7F701396EABG

P1L-C R7F701388, R7F701389, R7F701390, R7F701391

R7F701304, R7F701305, R7F701310, R7F701311, R7F701312,
P1M R7F701313, R7F701314, R7F701315, R7F701318, R7F701319,
R7F701320, R7F701321, R7F701322, R7F701323

P1M-C R7F701373xABG, R7F701374xAFP, R7F701397xABG

R7F701375, R7F701376, R7F701377, R7F701378, R7F701379,
P1M-E R7F701380, R7F701381, R7F701382, R7F701383, R7F701384,
R7F701385, R7F701386

R7F701060xAFP, R7F701062xAFP, R7F701064xAFP,
- R7F701065xAFP, R7F701067xAFP, R7F701069xAFP,

R7F701071xAFP
U2A-EVA R7F702Z19A, R7F702Z219B

U2A16 R7F702300, R7F702300A, R7F702300B

U2A6 R7F702302

U2A8 R7F702301, R7F702301A, R7F702301B

U2B10 R7F70254x_Fusa, R7F70254x_Performance, R7F702Z21,
R7F702Z26
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u2B24

R7F702Z23, R7F702228

U2B6

R7F70255x, R7TF702Z222

D1A

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD,
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD,
R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG,
R5F10DMJ, R5F10DPE, R5F10DPF, R6F10DPG, R5F10DPJ,
R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL,
R5F10TPJ

F12

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D,
R5F1096E, R5F109AA, R5F109AB, R5F109AC, R5F109AD,
R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD,
R5F109BE, R5F109GA, R5F109GB, R5F109GC, R5F109GD,
R5F109GE, R5F109LA, R5F109LB, R5F109LC, R5F109LD,
R5F109LE

F13

R5F10A6A, R5F10A6C, R5F10A6D, R5F10AGE, RSF10AAA,
R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC,
R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD,
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD,
R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF,
R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF,
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF,
R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF,
R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF,
R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG

RL78

F14

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD,
R5F10PGE, R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ,
R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ,
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ,
R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ

F15

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK,
R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK,
R5F113PL, R5F113TG, R5F113TH, R5F113TJ, R6F113TK,
R5F113TL

F1A

R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG

F1E

R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF,
R5F11LLG

F23

R7F123FBG, R7F123FGG, R7F123FLG, R7F123FMG,(Debug
Support Only)

F24

R7F124FBJ, R7TF124FGJ, R7F124FLJ, R7TF124FMJ, R7F124FPJ

FGIC

RAJ240055, RAJ240057, RAJ240090, RAJ240100,
RAJ240310,(Debug Support Only)

G10

R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46,
R5F10Y47

G11

R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A

G12

R5F 10266, R5F10267, R5F10268, R5F10269, R5F1026A,
R5F10277, R5F10278, R5F10279, R5F1027A, R5F102A7,
R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367,
R5F10368, R5F10369, R5F1036A, R5F10377, R5F10378,
R5F10379, R5F1037A, R5F103A7, R5F103A8, R5F103A9,
R5F103AA

R20UT5328EG0100
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R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A,
R5F1007C, R5F1007D, R5F1007E, R5F1008A, R5F1008C,
R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD,
R5F100AE, R5F100AF, R5F100AG, R5F100BA, R5F100BC,
R5F100BD, R5F100BE, R5F100BF, R5F100BG, R5F100CA,
R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG,
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF,
R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD,
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100F J,
R5F100FK, R5F100FL, R5F100GA, R5F100GC, R5F100GD,
R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ,
R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE,
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK,
R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF,
R5F100LG, R5F100LH, R5F100LJ, R5F100LK, R5F100LL,
R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK,
R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ,
R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK,

G13 R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E,
R5F1017A, R5F1017C, R5F1017D, R5F1017E, R5F1018A,
R5F1018C, R5F1018D, R5F1018E, R6F101AA, R5F101AC,
R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA,
R5F101BC, R5F101BD, R5F101BE, R5F101BF, R5F101BG,
R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF,
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE,
R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC,
R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH,
R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC,
R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH,
R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD,
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ,
R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE,
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, RS5F101LK,
R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ,
R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH,
R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ,
R5F101SK, R5F101SL

G13A R5F140FK, R5F140FL, R5F140GK, R5F140GL, R5F140LK,
R5F140LL, R5F140PK, R5F140PL

R5F104AA, R5F104AC, R5F104AD, R5F104AE, RSF104AF,
R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE,
R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD,
R5F104CE, R5F104CF, R5F104CG, R5F104EA, R5F104EC,
R5F104ED, R5F104EE, R5F104EF, R5F104EG, R5F104EH,
R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF,
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC,

G14 R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH,
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD,
R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ,
R5F104LC, R5F104LD, R5F104LE, R5F104LF, R5F104LG,
R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF,
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, RS5F104ML,
R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK,
R5F104PL

G15 R5F12007, R5F12008, R5F12017, R5F12018, R6F12047, R5F 12048,
R5F12067, R5F12068
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G16

R5F1211A, R5F1211C, R5F1214A, R5F1214C, R5F1216A,
R5F1216C, R5F1217A, R5F1217C, R5F121BA, R5F121BC

G1A

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA,
R5F10EBC, R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC,
R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE

G1C

R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC

G1D

R5F11AGG, R5F11AGH, R5F11AGJ

G1E

R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD,
R5F10FME

G1F

R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC,
R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, RSF11BLE

G1G

R5F11EA8, R5F11EAA, R6F11EB8, R5F11EBA, R5F11EFS,
R5F11EFA

G1H

R5F11FLJ, R5F11FLK, R5F11FLL

G1K

R5F11VBG, R5F11VLG

G1M

R5F11W67, R5F11W68

G1N

R5F11Y67, R5F11Y68

G1P

R5F11Z7A, R5F11ZBA

G22

R7F102G4C, R7F102G4E, R7F102G6C, R7F102G6E, R7F102G7C,
R7F102G7E, R7F102G8C, R7F102G8E, R7TF102GAC, R7F102GAE,
R7F102GBC, R7F102GBE, R7F102GCC, R7F102GCE, R7F102GEC,
R7F102GEE, R7F102GFC, R7F102GFE, R7F102GGC, R7F102GGE

G23

R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF,
R7F100GBG, R7F100GBH, R7F100GBJ, R7TF100GCF, R7F100GCG,
R7F100GCH, R7F100GCJ, R7F100GEF, R7F100GEG, R7F100GEH,
R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GFH, R7F100GFJ,
R7F100GFK, R7F100GFL, R7F100GFN, R7F100GGF, R7F100GGG,
R7F100GGH, R7F100GGJ, R7F100GGK, R7F100GGL,
R7F100GGN, R7F100GJF, R7F100GJG, R7F100GJH, R7F100GJJ,
R7F100GJK, R7F100GJL, R7F100GJN, R7F100GLF, R7F100GLG,
R7F100GLH, R7F100GLJ, R7F100GLK, R7F100GLL, R7F100GLN,
R7F100GMG, R7F100GMH, R7F100GMJ, R7F100GMK,
R7F100GML, R7F100GMN, R7F100GPG, R7F100GPH, R7F100GPJ,
R7F100GPK, R7F100GPL, R7F100GPN, R7F100GSJ, R7F100GSK,
R7F100GSL, R7TF100GSN

G24

R7F101G6E, R7F101G6G, R7F101G7E, R7F101G7G, R7F101G8E,
R7F101G8G, R7F101GAE, R7F101GAG, R7F101GBE, R7F101GBG,
R7F101GEE, R7F101GEG, R7F101GFE, R7F101GFG, R7F101GGE,
R7F101GGG, R7F101GJE, R7TF101GJG, R7F101GLE, R7F101GLG

H1D

R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME,
R5F11NMF, R6F11NMG, R5F11PLF, R5F11PLG, R5F11RMG

1A

R5F1076C, R5F107AC, R5F107AE, R5F107DE

1B

R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG

MC

R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ,
R5F10NML, R5F10NML_DUAL, R5F10NPG, R5F10NPJ, R5F10NPL,
R5F10NPL_DUAL

1C-2

R5F11TLE, R5F11TLG

1D

R5F11768, R6F1176A, R5F11778, R5F1177A, RSF117A8,
R5F117AA, R5F117AC, R5F117BA, R6F117BC, R6F117GA,
R5F117GC

ME

R5F11CBC, R5F11CCC
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R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA,

L12 R5F10RFC, R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJS,
R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC
R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF,

L13 R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME,
R5F10WMF, R5F10WMG

L1A R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF,
R5F11MPG
R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ,
R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ,

L1C R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ,
R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ,
R5F111NE, R5F111NF, R5F111NG, R5F111NH, R5F111NJ,
R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117,
R5F51118, R5F5111J

113 R5F51135, R5F51136, R5F51137, R5F51138

130 R5F51303, R5F51305, R5F51305B, R5F51306, R5F513068B,
R5F51307, R5F51308

13T R5F513T3, R5F513T5

140 R5F51403, R5F51405, R5F51406

210 R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108,
R5F5210A, R5F5210B

21A R5F521A6, R5F521A7, R5F521A8

220 R5F52201, R5F52203, R5F52205, R5F52206

230 R5F52305, R5F52306

231 R5F52315, R5F52316, R5F52317, R5F52318

23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S
23E-B R5F523E5B, R5F523E6B

23T R5F523T3, R5F523T5

RX

23w R5F523W7, R5F523W8

24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE

24U R5F524UB, R5F524UC, R5F524UE

06T R5F526T8, R5F526T9, REF526TA, R5F526TB, R5F526TF,
R5F526TF_DUAL

610 R5F56104, R5F56106, R5F56107, R5F56108

621 R5F56216, R5F56217, R5F56218

62G R5F562G7, R5F562GA

62N R5F562N7, R5F562N8

62T R5F562T6, R5F562T7, RSF562TA

630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D,
R5F5630E
R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B,

631 R5F5631D, R5F5631E, R5F5631F, R5F5631G, R5F5631J,
R5F5631K, R5F5631M, R5F5631MF, R5F5631N, R5F5631P,
R5F5631PF, R5F5631W, R5F5631Y, R5S56310

634 R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E,
R5F5634E_5V
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63N R5F563NA, R5F563NB, R6F563ND, R5F563NE, R6F563NF,
R5F563NK, R5F563NW, R5F563NY

63T R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V,
R5F563TC, R5F563TC_5V, R5F563TE, R5F563TE_5V

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML

R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL,
R5F5651E, R5F5651E_DUAL

651
R5F56519DMB, R5F5651EDMB, R5F5651EDMB_DUAL,(Debug
Support Only)
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL,
R5F565NE, R5F565NE_DUAL

65N
R5F565N9DMB, R5F565NEDMB, R5F565NEDMB_DUAL,(Debug
Support Only)

65W-A R5F565WE, R5F565WE DUAL,

R5F56604A, R5F56604B, R5F56604C, R5F56604D, R5F56604E,

660 R5F56604F, R5F56604G, R5F56604H, R5F56609A, R5F56609B,
R5F56609C, R5F56609D, R5F56609E, R5F56609F, R5F56609G,
R5F56609H

66N R5F566ND, R5F566ND DUAL, R5F566NN, R5SF566NN DUAL

66T R5F566TA, R5F566TAXXFL, R5F566TE, R5F566 TEXXFL,
R5F566TF, R5SF566TK

671 R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL,
R5F5671E, R5F5671E DUAL

71M R5F571MF, R5F571MG, R5F571MJ, R5F57 1ML

72M R5F572MD, R5F572MD DUAL, R5F572MN, R5F572MN DUAL

72N R5F572ND, R5F572ND DUAL, R5F572NN, R5F572NN DUAL

72T R5F572TF, R5F572TK

. ROES57 1MLDMBXX, (Debug Support Only)

R7S721000, R7S721000_DualSPI, R7S721001,
R7S721001_DualSPI, R7S721010, R7S721010_DualSPI,
A1 R7S721011, R7S721011_DualSPI, R7S721020,
R7S721020_DualSPI, R7S721021, R7S721021_DualSPI,
R7S721030, R7S721030_DualSPI, R7S721031,
R7S721031_DualSPI, R7S721034, R7S721034_DualSPI

R75921040, R7S921041, R7S921042, R7S921043, R75921045,

A2 R78921046, R7S921047, R7S921048, R7S921051, R7S921052,
R78921053, R7S921056, R7S921057, R7S921058
RZ A3UL R9A07G063U01, R9A07G063U02
G1E R8A77450, R8A77450 Core1,(Debug Support Only)
G1M R8A77430, R8A77430 Core1,(Debug Support Only)

R9A07G044C12GBG_CM33, R9A07G044C22GBG_CM33,
R9A07G044L13GBG_CM33, ROA07G044L14GBG_CM33,

G2l RIA07G044L23GBG_CM33, ROA07G044L24GBG_CM33.
ROA07G044LC_M33. ROAO7G044L M33
G2UL ROA07G043U11GBG_CM33, R9A07G043U12GBG_CM33
N2L ROA07G084M04, ROA07GO84MO8
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T1

R75910001, R7S910002, R7S910006, R7S910007, R7S910011,
R7S910013, R7S910015, R7S910015_M3, R7S910016,
R7S910016_M3, R7S910017, R7S910017_M3, R7S910018,
R75910018_M3, R7S910025, R75910026, R7S910027, R7S5910028,
R75910035, R7S910036, R7S910101, R7S910102, R7S910106,
R7S5910107, R7S910111, R7S910113, R7S910115, R7S910115_M3,
R7S910116, R7S910116_M3, R7S910117, R7S910117_M3,
R7S910118, R7S910118_M3, R7S910125, R7S910126, R7S910127,
R7S910128, R7S910135, R7S910136

T1-M

R7S910020, R7S910021, R7S910022, R7S910023, R75910120,
R7S910121, R7S910122, R7S910123

T2L

R9A07G074M01, R9A07G074M04, ROA07G074MO05,
R9A07G074M08

T2M

R9A07G075M01, R9A07G0O75M05, R9A07G0O75M21_CPUO,
R9A07G075M21_CPU1, ROA07G075M22_CPUO,
R9A07G075M22_CPU1, ROA07G075M24_CPUO,
R9A07G075M24_CPU1, ROA07G075M26_CPUO,
RY9A07G075M26_CPU1, ROA07G075M27_CPUO,
RY9A07G075M27_CPU1, ROA07G075M28_CPUO,
RY9A07G075M28 CPU1

V2L

RY9A07G054L13GBG_CM33, ROA07G054L13_M33,
R9A07G054L14GBG_CM33, ROA07G054L14_M33,
R9A07G054L23GBG_CM33, RO9A07G054L23_M33,
R9A07G054L24GBG_CM33, R9A07G054L24 M33

S1JA

S124

R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF,
R7FS1JA782A01CBT, R7TFS1JA783A01CFJ

R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM,
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM,
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF

5128

R7FS128782A01CLM, R7FS128783A01CFJ, R7TFS128783A01CFL,
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG

S3A1

R7FS3A17C2A01CLK, R7TFS3A17C3A01CFB, R7FS3A17C2A01CBJ,
R7FS3A17C2A01CLJ, R7TFS3A17C3A01CFM,
R7FS3A17C3A01CFP, R7TFS3A17C3A01CNB

S3A3

R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7TFS3A37A2A01CBJ,
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7TFS3A37A3A01CFM,
R7FS3A37A3A01CNB

S3A6

R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7TFS3A6783A01CFM,
R7FS3A6783A01CFP, R7TFS3A6783A01CNB, R7TFS3A6783A01CNE,
R7FS3A6783A01CNF

Synergy

S3A7

R7FS3A77C2A01CLK, R7TFS3A77C3A01CFB, R7FS3A77C2A01CBJ,
R7FS3A77C3A01CFP, R7TFS3A77C2A01CLJ, R7TFS3A77C3A01CFM,
R7FS3A77C2A01CNB, R7TFS3A77C3A01CNB

S5D3

R7FS5D37A2A01CLJ, R7TFS5D37A3A01CFP, R7TFS5D37A3A01CFM,
R7FS5D37A3A01CNB

S5D5

R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP,
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP

S5D9

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC,
R7FS5D97C2A01CLK, R7FS5D97C3A01CFB,
R7FS5D97C3A01CFP,

R7FS5D97E2A01CBG, R7FS5D97E3A01CFC,
R7FS5D97E2A01CLK, R7TFS5D97E3A01CFB, R7TFS5D97E3A01CFP

S7G2

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD,
R7FS7G27H2A01CBG,
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC,
R7FS7G27H3A01CFC,
R7FS7G27G2A01CFC, R7TFS7G27G3A01CFC,
R7FS7G27H2A01CLK,
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R7FS7G27G2A01CLK, R7TFS7G27H3A01CFB,
R7FS7G27G3A01CFB, R7TFS7G27G3A01CFP

R20UT5328EG0100  Rev.1.00 Page 17 of 61
20th July 2023 RENESAS



e? studio 2023-07 Release Documentation Release Note

2.2 Code Generator Support — Windows Host Only

Family Group

Devices

D1A

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME,
R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD,
R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF,
R5F10DPG, R5F10DPJ, R5F10TPJ

F12

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E,
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA,
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB,
R5F109GC, R5F109GD, R5F109GE, R5F109LA, RSF109LB, R5F109LC,
R5F109LD, R5F109LE

F13

RL78

R5F10A6A, R5F10A6C, R5F10A6D, R5F10AGE, R5F10AAA, R5F10AAC,
R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE,
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG,
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME,
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF,
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG,
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC,
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF,
R5F10BMG

F14

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE,
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF,
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG,
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH,
R5F10PPJ

F15

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML,
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG,
R5F113TH, R5F113TJ, R5F113TK, R5F113TL

F1E

R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF, RS5F11LLG

G10

R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47

G11

R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A

G12

R5F10266, R5F10267, R5F10268, R5F10269, R6F1026A, R5F10277, R5F10278,
R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, R5F102AA,
R5F10366, R5F10367, R5F10368, R5F10369, R6F1036A, R5F10377, R5F10378,
R5F10379, R5F1037A, R5F103A7, R5F103A8, R5F103A9, RSF103AA
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R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C,
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E,
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG,
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG,
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG,
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG,
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF,
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA,
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH,
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE,
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, R5F100LC,
R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, R5F100LJ,
R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, R5F100MJ,
R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ,
G13 R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, R5F100SL,
R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, R5F1017C,
R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, R5F1018E,
R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, R5F101AG,
R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, R5F101BG,
R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, R5F101CG,
R5F101EA, R5F101EC, R5F101ED, R5F101EE, R56F101EF, R5F101EG,
R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, RSF101FF,
R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, R5F101GA,
R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH,
R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, R5F101JE,
R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, R5F101JL, R5F101LC,
R5F101LD, R5F101LE, R5F101LF, R5F101LG, R5F101LH, R5F101LJ,
R5F101LK, R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ,
R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, R5F101PJ,
R5F101PK, R5F101PL, R5F101SH, R5F101SJ, R5F101SK, R5F101SL

G13A R5F140FK, R5F140FL, R5F140GK, R5F140GL, R5F140LK, R5F140LL,
R5F140PK, R5F140PL

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG,
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG,
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG,
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, RSF104EG,
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, RSF104FF,

G14 R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD,
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK,
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG,
R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF,
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF,
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF,
R5F104PG, R5F104PH, R5F104PJ, RSF104PK, R5F104PL

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC,
G1A R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE,
R5F10ELC, R5F10ELD, R5F10ELE

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC

G1D R5F11AGG, R5F11AGH, R5F11AGJ

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME

G1F R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE,
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, RS5F11EF8, RSF11EFA

G1H R5F11FLJ, R5F11FLK, R5F11FLL
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H1D  R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF,
R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG
1A R5F1076C, R5F107AC, R5F107AE, R5F107DE
1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG
11c  R5F1ONLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NML,
R5F10NML_DUAL, R5F10NPG, R5F10NPJ, R5F10NPL, R5F10NPL_DUAL
11C-2  R5F11TLE, R5F11TLG
MD  R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, REF117AA,
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC
ME  R5F11CBC, R5F11CCC
R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC,
L12 R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC,
R5F10RLA, R5F10RLC
L13  R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG,
R5F10WMA, R5F10WMC, R5F10WMD, R5F 10WME, R5F10WMF, R5F10WMG
L1A_ R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, R5F11MPG
R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE,
L1C  R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF,
R5F111MG, R5F111MH, R5F111MJ, R5F111PE, R5F111PF, R5F111PG,
R5F111PH, R5F111PJ
110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J
111  R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, R5F51118,
R5F5111
113 R5F51135, R5F51136, R5F51137, R5F51138
130 R5F51303, R5F51305
230  R5F52305, R5F52306
RY 231 R5F52315, R5F52316, R5F52317, R5F52318
23T R5F523T3, R5F523T5
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE
24U R5F524UB, R5F524UC, R5F524UE
64M  R5F564MF, R5F564MG, R5F564MJ, R5F564ML
651  R5F56514, R5F56517, R5F56519
65N R5F565N4, R5F565N7, R5F565N9
71M  R5F571MF, R5F571MG, R5F571MJ, R5F57 1ML
R7S910001, R7S910002, R7$910006, R7S910007, R7S910011, R7S910013,
R7S910015, R7S910016, R7$910017, R7S910018, R7S910025, R7S910026,
R7 11  R7S910027, R7S910028, R7S910035, R7S910036, R7S910101, R7S910102,
R7S910106, R7S910107, R7S910111, R7S910113, R7S910115, R7S910116,
R7S910117, R7S910118, R7S910125, R7S910126, R7S910127, R7S910128,
R7S910135, R7S910136
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23 Smart Configurator Support

Family Group Devices
F23 R7F123FBG, R7F123FGG, R7F123FLG, R7F123FMG
F24 R7F124FBJ, R7TF124FGJ, R7F124FLJ, R7TF124FMJ, R7F124FPJ
R5F12007, R5F12008, R5F12017, R5F12018, R5F12047, R5F 12048,
G15 R5F12067, R5F12068
R5F1211A, R5F1211C, R5F1214A, R5F1214C, R5F1216A, R5F1216C,
G16 R5F1217A, R5F1217C, R5F121BA, R5F121BC

R7F102G4C, R7F102G4E, R7F102G6C, R7F102G6E, R7F102G7C,
R7F102G7E, R7F102G8C, R7F102G8E, R7F102GAC, R7F102GAE,
R7F102GBC, R7F102GBE, R7F102GCC, R7F102GCE, R7F102GEC,
G22 R7F102GEE, R7F102GFC, R7F102GFE, R7F102GGC, R7F102GGE
R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF,
R7F100GBG, R7F100GBH, R7F100GBJ, R7F100GCF, R7F100GCG,
RL78 R7F100GCH, R7F100GCJ, R7F100GEF, R7TF100GEG, R7F100GEH,
R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GFH, R7F100GFJ,
R7F100GFK, R7F100GFL, R7F100GFN, R7F100GGF, R7F100GGG,
R7F100GGH, R7F100GGJ, R7F100GGK, R7F100GGL, R7F100GGN,
R7F100GJF, R7F100GJG, R7F100GJH, R7F100GJJ, R7TF100GJK,
R7F100GJL, R7F100GJN, R7F100GLF, R7F100GLG, R7F100GLH,
R7F100GLJ, R7F100GLK, R7F100GLL, R7F100GLN, R7F100GMG,
R7F100GMH, R7F100GMJ, R7F100GMK, R7F100GML, R7F100GMN,
R7F100GPG, R7F100GPH, R7F100GPJ, R7F100GPK, R7F100GPL,
G23 R7F100GPN, R7F100GSJ, R7F100GSK, R7F100GSL, R7F100GSN
R7F101G6E, R7F101G6G, R7F101G7E, R7F101G7G, R7F101G8E,
R7F101G8G, R7F101GAE, R7F101GAG, R7F101GBE, R7F101GBG,
R7F101GEE, R7F101GEG, R7F101GFE, R7F101GFG, R7F101GGE,

G24 R7F101GGG, R7F101GJE, R7TF101GJG. R7F101GLE, R7F101GLG
110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F51104
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117,
111 R5F51118. R5F5111J
113 R5F51135, R5F51136, R5F51137, R5F51138
R5F51303, R5F51305, R5F513058, R5F51306, R5F51306B, R5F51307,
130 R5F51308
13T R5F513T3, R5F513T5
140 R5F51403, R5F51405, R5F51406
230 R5F52305, R5F52306
231 R5F52315, R5F52316, R5F52317, R5F52318
RX 23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S
23E-B R5F523E5B, R5F523E6B
23T R5F523T3, R5F523T5
23W R5F523W7, R5F523W8
24T R5F524T8, REF524TA, R5F524TB, R5F524TC, REF524TE
24U R5F524UB, R5F524UC, R5F524UE
R5F526T8, R5F526T9, R5F526TA, R5F526TB, RGF526TF,
26T R5F526TF DUAL
64M R5F564MF, R5F564MG, R5F564M.J, REF564ML
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL,
651 R5F5651E, R5F5651E DUAL
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R5F565N4, R5F565N7, RSF565N9, RSF565NC, R5F565NC_DUAL,

65N R5F565NE, R5F565NE DUAL
R5F56604A, R5F56604B, R5F56604C, R5F56604D, R5F56604E,
R5F56604F, R5F56604G, R5F56604H, R5F56609A, R5F566098B,
R5F56609C, R5F56609D, R5F56609E, R5F56609F, R5F56609G,

660 R5F56609H

66N R5F566ND, R5F566ND DUAL, R5F566NN, R5F566NN_DUAL

66T R5F566TA, R5F566TE, R5F566TF, R5SF566TK
R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL,

671 R5F5671E, R5F5671E DUAL

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML

72M R5F572MD, R5F572MD DUAL, R5F572MN, R5F572MN_DUAL

72N R5F572ND, R5F572ND DUAL, R5F572NN, R5F572NN DUAL

72T R5F572TF, R5F572TK

A2 R7S921040, R7S921041, R7S921042, R7S921043, R7S921045,
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052,
R7S921053, R7S921056, R7S921057, R7S921058

A3UL RIA07G063U01, ROA07G063U02

N2L R9OA07G084M04, ROAO7G084MOS

T2L RIA07G074MO01, ROA07G074M04, ROA07G074MO05, ROA07G074M0O8
R9A07G075M01, ROA07G075M05, ROA07G075M21_CPUO,
R9A07G075M21_CPU1, ROA07G075M22_CPUO,
R9A07G075M22_CPU1, ROA07G075M24_CPUO,

T2M R9A07G075M24_CPU1, ROA07G075M26_CPUO,

RZ R9A07G075M26_CPU1, ROA07G075M27_CPUO,
R9A07G075M27_CPU1, ROA07G075M28_CPUO,
R9A07G075M28 CPU1
R9A07G044C12GBG_CM33, R9A07G044C22GBG_CM33,

6oL R9A07G044L13GBG_CM33, ROA07G044L14GBG_CM33,
R9A07G044L23GBG_CM33, ROA07G044L24GBG_CM33,
R9A07G044LC M33, ROA07G044L M33

G2UL R9A07G043U11GBG CM33, ROA07G043U12GBG CM33
R9A07G054L13GBG_CM33, R9A07G054L13 M33,

VoL R9A07G054L14GBG_CM33, ROA07G054L14 M33,
R9A07G054L23GBG_CM33, ROA07G054L23 M33,
RIA07G054L24GBG CM33, ROA07G054L24 M33

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF,
R7FS1JA782A01CBT, R7FS1JA783A01CFJ
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM,

S124 R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM,
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF

5128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL,
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG

Synergy R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ,

S3A1 R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM,
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ,

S3A3 R7FS3A37A2A01CLJ, R7TFS3A37A3A01CFP, R7TFS3A37A3A01CFM,
R7FS3A37A3A01CNB
R7FS3A6782A01CLJ, R7TFS3A6783A01CFL, R7TFS3A6783A01CFM,

S3A6 R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE,
R7FS3A6783A01CNF

R20UT5328EG0100 Rev.1.00 Page 22 of 61
20th July 2023 RENESAS



e? studio 2023-07 Release Documentation Release Note

R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7TFS3A77C2A01CBJ,
S3A7 R7FS3A77C3A01CFP, R7TFS3A77C2A01CLJ, R7TFS3A77C3A01CFM,
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB

R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM,
R7FS5D37A3A01CNB

S5D3

R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7TFS5D57A3A01CFP,
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, R7FS5D97C2A01CLK,

R7FS5D97C3A01CFB, R7FS5D97C3A01CFP,

R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7TFS5D97E2A01CLK,

R7FS5D97E3A01CFB, R7FS5D97E3A01CFP

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7TFS7G27H2A01CBG,

R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7TFS7G27H3A01CFC,

S7G2 R7FS7G27G2A01CFC, R7TFS7G27G3A01CFC, R7TFS7G27H2A01CLK,
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7TFS7G27G3A01CFB,
R7FS7G27G3A01CFP

S5D5

S5D9

R7FA2A1AB, R7TFA2E1A5, R7TFA2E1A7, R7TFA2E1A8, R7TFA2E1A9,
RA2 R7FA2E2A3, R7TFA2E2A5, R7TFA2E2A7, R7TFA2L1A9, R7FA2L1AB

R7FA4E10B, R7TFA4E10D, R7FA4E2B9, R7TFA4M1AB, R7TFA4M2AB,
R7FA4M2AC, R7TFA4AM2AD, R7TFA4M3AD, R7TFAAM3AE, R7TFA4M3AF,
R7FA4T1B9, R7TFA4T1BB, R7TFA4W1AD

RA RA4
R7FAGE10D, R7FAGE10F, R7TFAGE2B9, R7TFAGE2BB, R7TFAGM1AD,
R7FA6M2AD, R7TFA6M2AF, R7TFA6M3AF, R7TFA6M3AH, R7FAGM4AD,
R7FAGM4AE, R7TFA6M4AF, R7TFA6MSAG, R7TFA6M5AH, R7FAGMSBF,
R7FA6M5BG, R7TFA6M5BH, R7FAG6T1AB, R7TFAG6T1AD, R7TFAGT2AB,
RAG R7FA6T2AD, R7TFA6T2BB, R7TFA6T2BD, R7TFAG6T3BB
REO1B R7FOE01BD2DNB

R7FOE014D2CFB, R7FOE014D2CFP, R7FOE015D2CFB,
R7FOE015D2CFP, R7FOE016D2DBN, R7FOE017D2DBN

R7FOE01082CFM, R7FOE01082CFP, R7FOE01082DBH,
R7FOE01082DBR, R7FOE01082DNG, R7FOE01182CFM,
R7FOE01182CFP, R7FOE01182DBH, R7FOE01182DBR,
R7FOE01182DNG

RE REO1_1500KB

REO1_256KB
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3. Smart Manual Support

Smart manual support is delivered independently of e? studio releases when available. The following devices are
available as of January 2023:

e RXI110 e RL78/G10

e RXII11 e RL78/Gl1

e RXI13 e RL78/G12

e RXI130 e RL78/G13

e RXI3T e RL78/Gl14

e RX140 e RL78/G15

e RX210 e RL78/Gl6

e RX220 e RL78/GIF

e RX230 e RL78/G22

e RX231 e RL78/G23

e RX23E-A e RL78/L12

e RX23W e RL78/L13

e RX24T e RZ/AIH

e RX24U e RZ/AIL

e RX26T e RZ/A2M

e RX62G e RZ/T1

e RXO62T e RZ/T2M

e RX631 e RZ/N2L

e RX63N e RA2EI]

e RX63T e RA2E2

e RX64M e RA2LI1

e RX651 e RAA4EI1

e RX65N e RA4E2

e RX660 e RA4M2

e RX66T e RA4TI

e RX66N e RAG6EI]

e RX671 e RAG6E2

e RX7IM e RA6M4

e RX72M e RAO6OMS

e RX72N e RA6T2

e RX72T e RA6T3
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To view the Smart Manual support in ¢? studio please use the following method:

1.

Please open the Smart Manual view. Available on the Renesas Views->Solution Toolkit->Smart Manual menu
from the Menu bar.

Then use the “Install new Smart Manual...” option seen in the figure below:

L‘ﬂ Pin Conflicts & Console _ Smart Manual <‘="=‘> ee] E = d

Register Search  Keyword Search Install New Smart Manuals...

Manage Smart Manuals

I <] [6o] Device:-

(There is no information.)

A dialog is then displayed which shows all available Smart Manuals.

& install O X

Install Extensions %
]

Select extensions to install, Press Finish to proceed with installation,
Press the information button to see a detailed overview and a link to mere infarmation,

Find: | | | ] 5how |nstalled

~

RL78 Smart Manuals

O Renesas RL78/G10 Smart Manual (v3.11)
Smart Manual for RLY8/G10 Devices

Renesas Electronics Corp.

[0 Renesas RL78/G11 Smart Manual (v2.20)

Smart Manual for RL78/G11 Devices

Renesas Electronics Corp.

L Renesas RL78/G12 Smart Manual (v2.20)

Smart Manual for RL78/G12 Devices
Renesas Electronics Corp.

O Renesas RL78/G13 Smart Manual (v3.40)
Smart Manual for RLY8/G13 Devices

Renesas Electronics Corp.

[0 Renesas RL78/G14 Smart Manual (v3.30)
Smart Manual for RL78/G14 Devices

Renesas Electronics Corp.

O Renesas RL78/G1F Smart Manual (v1.10)

Crmark Mamna | fnr R 72ACAE Nanvimar

@' Finish Cancel
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4. What is new in 2023-077?

Component Device Description

The e? studio installer has been revised to include different modes of
install to improve the ease of use for different use cases.

We now have 3 modes to choose from:

e Lite Install (Recommended)
e Standard Install
e Custom Install

Lite Install mode provides a simplified experience focusing on simple
coding and debugging. It includes all important features for normal
development.

The Standard Install mode provides everything you get in the Lite Install
with additional features for more advanced and in-depth debugging.

The Custom Install Mode gives you more control over what is installed
and gives you various choices to customize your e? studio product install.

A detailed list of what is installed in each mode is here:

Renesas e? studio Features List

|nSta||er‘ All [EA Renesas & studio 2023-07 Setup [} ®

Renesas e° studio 2023-07 Setup RE NESAS

Install Type

Please select the &° studio installation type. Click here for help selecting a type and to see what features are included.

Select Install Type:

Lite Install (Recommended)
This installs & studio in Lite Mode.
This mode offers a simplified experience focused on simple code editing & debugging with only important features

Standard Install
This installs € studio in Advanced Mode.
This mode offers all extended debugging functionality and other advanced features

Custom Install
Custom installation of & studio
This mode is allows you to select which features are installed

v202306151937 User: All Users < Back Next > Install Cancel
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CDT All CDT has been updated to 11.1.1. See CDT 11.1 New and Noteworthy

Eclipse Platform has been updated to 4.27. Details can be found

Eclipse All here: Eclipse platform Release Information

Improvements have been made to the 10 Registers, Expressions view
and Memory view that allows a faster way to create a hardware eventpoint
for the selection in the view.

The feature is available via the view pop-up menu and is named "Add
Event Break".

()= Vari... | ® Brea... |5 Proj... |97 Expr.. X |@® Eve.. |2 Peri.. ||| 10.

50| X% Q%

Expression Type Value Address Name : value
- e Details:

Select All Ctrl+ 4

()= value int
g Add nev
Copy Expressions Crl+C

Remove

Rermowe All

ﬁ ﬁ I

Mumber Format >
Add Expression Group ¥
Find... Ctrl+F

Eventpoints All

Show Details As >

o Add Watch Expression...
Disable

Enable

Edit Watch Expression...
Add Watchpoint (C/C++]...
Cast To Type..

é :& "tz.%

Display As Array...
Enable Real-time Refresh
Real-time Refresh >

v

€ Add Event Break Renesas Eventpoints »
F-_j'f‘" Watch

Configuring event points from the Eventpoints view is not always easy.

The 10 Registers view now provides the ability to create an event break
IO Registers Al on a selected register to the Eventpoints.

Some event settings will also be automatically configured based on the
register's information.
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I 10 Registers X

Name Value (Hex)
MPU
%, NVIC
v SCB
it CPUID Oxd10fc241
Wi ICSR 0x00000000
i VIOR 0x00000000
1 AIRCR OxfaD50000
1 SCR 0x00000000
> Wi CCR 000000200

Add to Selected Registers

¥ [ Collapse all other groups
Refresh

Lock Refresh

Expand All Groups
Collapse All

NHe%

Find

Manage Selected Registers..
Print Expanded Groups

Save

Copy

Show Value (Bin) column
Show Access column
Renesas Eventpoints

All Registers Selected Registers

Address

Oxe000edS0
0xe000e100
0xe000ed00
Oxe000ed00
(Oxe000ed04
0xe000ed08
0xe000edOc
(Oxe000ed10
Oxe000ed14
Oxe000ed18
OxeD00ed1c
Oxe000ed20
Oxe000ed24
Oxe000ed28
0Oxe000ed2c
Oxe000ed34
Oxe000ed38
0Oxe000ed3c
Oxe000edB8
0xe000e000
0xe000e004
Oxe000e008
Oxe000e010
0xe000e010
Oxe000e014

Description

Serial Control Register (SCMR.SMIF = 0)

Acceptance Filter Support Register

>l €0 Add Event Break l

While debugging/analyzing problems often it is needed to save the state

of the 1/O registers so
another state.

they can be later be analyzed/differenced with

It is now possible to select registers in the 10 Registers window and copy

to clipboard.

Mame Walue (Hex) Address

v 2 BSC
8 BERCLR 000 O 00021300
141 BERENM e 00 O 00031304
1010 "

» afat BERSR ¢ Addto Selected Registers
Y BERSR2
1010 BUSPR] Remove from Selected Registers
Lo CSOMOD —| Collapse all other groups
o CS0WCR
10 Registers Al 10 CSOWCR2 S

-!.?-!.? CSIMOD @ Lock Refresh
i CSTWCRT Expand All Groups
st CSTWCRZ 5 Collapse All
o CE2ZMOD
e csawcr1 |4 Find
W0 CS2WCR2 9§ Manage Selected Registers...
oii C33MOD & prin Expanded Groups
e CE3WCR H Cave
aint CS3WCR2 | o
1010 CSAMOD =| Copy Ctrl + C
lotn CEAWCRT Add Tl'af-:r Selected Register
oy CS4WCR2 :
1010 CSSMOD [ Show Value (Bin} column
i reswepd | L] Show Access column

All Registers  Selected REGIStEr

. You can now save all 10 register info to a text file. Output from this feature
IO Registers Al .
can be seen below:
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= |
1| 1 1 1 1 1 1
= Module Register Address Value Access Size

I | | | I I
4 4BsC
& BERCLR 0x00081300 oo RW =)
7 STSCLR [o] 0
BEREN 0x00081304 oo RW =)
S TOEN [1] 0
10 IGAEN [o] o
11 BERSRL 0x00081308 oo RW 2
1z MST [6:4] 0
13 TO [1] 0
14 In [o] 0
15 BERSR2 0x0008130a 0000 RW W
16 ADDR [15:3] 0
17 BUSERI 0x00081310 0000 RW W
1 BPEB [13:12] 0
1 BPFE [11:10] 0
2 SPHE [9:8] 0
21 BEGE [7:6] 0
22 BPIBE [5:4] 0
23 BPRO [3:2] 0
24 BPRL [1:0] 0

There is an improvement on project generation for FreeRTOS (with loT
libraries).

The previous project generation is renamed to "FreeRTOS (with loT
libraries)(deprecated structure)".

The new "FreeRTOS (with loT libraries)" uses FreeRTOS LTS for the
project generation.

Application selection is also available when creating new "FreeRTOS
(with IoT libraries)" project.

GCC for Renesas RX

Select toolchain, device & debug settings

RTOS Toolchain Settings
) RX
Configurator Language: ®c OC++
Toolchain: GCC for Renesas RX M
Toolchain Version: |8.3.0.202202 h2

Manage Toolchains...

RTOS:

RTOS Version:

FreeRTOS (kernel only)
FreeRTOS (with loT libraries)
FreeRTOS (with loT libraries)(deprecated structure)

Device Settings

Target Board: | CK-RX65N w

Download additional boards...

Target Device: |R5SF565NEHxFB
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Smart Configurator for RX updated to V2.18.0.

o BSP rev7.41 is supported and will be added as default BSP when
creating Smart Configurator RX project.

o RX26T (RAM size 48K) devices have been supported in Smart
Configurator

e GPT has been supported in Motor component for RX66T

e Sample project can be selected for creation for Smart
Configurator RX project, there are two kinds of sample projects
are available as below:

e O

New Renesas CC-RX Executable Project —

Description part

Project template selection

» Bare Metal - Minimal
® (} Bare metal project that includes BSP. This project will initialize clocks, pins, stacks and the C

runtime environment.

Bare Metal - Blinky

@ r’) Bare metal project that includes BSP and will blink LED1 if available. This project will initialize
clocks, pins, stacks and C runtime environment.

Smart

Configurator RX

'H?' < Back . Next> | Einish | Cancel

e The blinky project can be selectable when the selected boards
contain LED pin information.

e Compare view has been supported for helping user resolving the
user code merge conflict after generating codes for CG
components. You can easily compare the code differences before
and after, then resolve the conflict by a simple click or manual
editing on the right panel.
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o RSCI peripheral function has been supported for RX26T in
SCI/SCIF Asynchronous Mode, SCI/SCIF Clock Synchronous
Mode, SPI Clock Synchronous Mode, SCI Smart Card Interface
Mode and 12C Master Mode.

Reality Al RA, RX

The Reality Al features have been moved to a new top level menu item
"Renesas Al".

This is to aid usability and discoverability of these features.
The menus are disabled until you have authenticated with the Reality Al
website via the "Reality Al Authentication" menu:

File Edit Source Refactor Mavigate Search Project RenesasViews Run  Renesas Al Window Help
v Hovin e Qv @ Reality Al Authentication
[ Project Explorer X SN 7 & = | Delete selected & studio project from Reality Al Tools®
Link to Reality Al Tocls® project
There are ne projects in your workspace. Sync to Reality Al Tools &
To add a project: X 3

Download classifier from Reality Al Tools®

Reality Al RA, RX

The Reality Al plugins are no longer included as default within the e2
studio product.

These can be added when installing the product or added via the "Install
New Software..." feature when projects needing these plugins are
detected.

This separation allows us to update the Reality Al feature when the
website is also changed.

Reality Al RA, RX

In the previous version of e? studio it was possible to download the zip file
package from the Reality Al website via the e? studio user interface.

After this point you needed to extract and integrate this with your project
manually.

It is now possible for e? studio to manage this operation with a new
feature and user interface.

You can manage multiple classifiers and decide which is to be integrated
with the project. When added to the project the build settings are
configured to match the classifier selected.
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& Download dlassifier m] X
Download classifier from Reality Al Tools®
Specify directory to store and select classifier from Reality Al Tools® to download
Store directory
[JUse default directory
~ | Browse...

Directory: ‘

~

Reality Al project: SampleProject

Classifiers:
Deployed Name Package Date Data Type Target
[ test Mar 22, 2023 06:57:21 PM float RA6T2 (ARM Cortex-M33)
[ test Mar 22, 2023 07:27:06 PM float RA6T2 (ARM Cortex-M33)
[ test Mar 24, 2023 10:09:20 AM float RAGT2 (ARM Cortex-M33)

[Juse available classifier in the project
Package Date Data Type Target

Deployed Name Active Location

Download Cancel

Also, can switch between downloaded models/classifiers in the current
project.

Q Download classifier

Download classifier from Reality Al Tools®

Select available classifier in the project to use

Store directory
Use default directory
Browse

Directory:

Reality Al project:

Classifiers:

Deployed Name Package Date Data Type Target

Use available classifier in the project
Deployed Name Package Date Data Type Target
[ test Mar 22, 2023 07:27:06 PM float RA6T2 (ARM...

|

Active Location
No src/realityai

Switch Cancel

Smart Configurator updated to V1.7.

e RL78/G16 and RL78/G24 UM Rev1.0 catch-up.
RL78 e Support RL78/G24 TMKB3, DALI, TRD (Timer KB3 PWM Output
Gate Mode) and A/D (Advanced A/D mode).
Support new blinky project generation feature when selected the
target board with LED resource in project generation wizard.

Smart
Configurator
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'] o x

New Renesas CC-RL Executable Project —

Choose a project template.

Project template selection

Bare Metal - Minimal

O (} Bare metal project that includes BSP. This project will initialize clocks, pins, drivers and the C
runtime environment.

Bare Metal - Elinky

® (_} Bare metal project that includes BSP and will blink LED if available. This project will initialize
clocks, pins, drivers and C runtime environment.

I:?D' = Back Next = Cancel

Smart Configurator updated for RH850 to v1.9.

) User manual updated for RH850U2A and RH850/F1KM.

Configurator
Improved reset behavior options available in the ARM J-link Debug

ARM J-link RA. RZ, DA, Configuration

Debug RE, Synergy

Configuration ’ "Reset Behavior" category is added to Debug Tool Settings tab to set the
reset behavior for the debug models of the project.
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Mame: | ra_test Debug_Flat |

| Main | %5 Debugger| = Startup | [C] Common - Source

Debug hardware: | J-Link ARM ~ | Target Device: | RTFAGM3AH

GDB Settings Connection Settings  Debug Tool Settings

v Memory ~
Endian Little Endian ]

~ Break
Use Flash Breakpoints Yes v
Allow Simulation Mo v

~ Flash

Flash Bus Type
Flash Memery Type
WorkRam Start
WorkRam End

Erase on-chip program flash before download No v
Erase on-chip data flash before download No v
Use CFl-Flash Ne v
CFl Start 0x0
CFlEnd 0x0
w Semihosting
Semihosting breakpoint address
~ RTOS
RTOS Integration in Debug View No v
RTOS Debugging - Large Number of Threads. No v
w System
Allow caching of flash contents Yes v
w Time Measurement
Run Break Time Measurement Yes v
Count Every Core Cycle Yes v

Operating Frequency [MHz]

w Reset Behavior
Behavior of reset command Mormal Reset v
PC after reset
Set T-bit on CPSR after reset Mot specify

When using The Flexible Software Package (FSP) for RZ/T and RZ/N,

Developer RZ/T and Developer Assistance support is now available within the Project Explorer

Assist RZIN view and Properties view.
cbB RZ. RA, DA, GDB for the RZ device family has been updated to revision 12.
RE, Synergy This now contains Python 3.10.
The e? studio Segger J-link ARM debug configuration now allows you to
setup connection via a tunneling server.
SEGGER J-Link support a remote debug system that allows a PC in one
ARM J-link location to register J-Link units connected to it with a central server,
Debug RA,RZ DA, making them available for use from a debugger running on another PC

Configuration RE, Synergy  anywhere in the world.

More background information on this feature can be found at:
J-Link Remote Server
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Create, manage, and run configurations

FEoEX B Y-
[ type fikter text |
[5] C/C++ Application
[T] C/C++ Remote Application
=] EASE Script
[©] GDEB Hardware Debugging
[ GDB Simulator Debugging (RHE
& Launch Group

Name: | RA_test Debug_Flat |

5] Main [35 Debugger| - Startup | E- Source| [F] Common

Debug hardware: | J-Link ARM

~| Target Device: | RTFA2A1AB

GDB Settings  Connection Settings  Debug Tool Settings
~ J-Link ~

Type 1P o
v [T Renesas GDB Hardware Debuge J-Link Serial (Auto)
[E7 RA_test Debug_Flat Settings File Stworkspace loc:/S{ProjName}l/${LaunchConfigName},jlink

£ Renesas Simulater Debugging { Script File

Log File Stworkspace,_loc/S{ProjName}}/ILinkLog.log

Low Power Handling No v
~ IP Connection
Connection Method P vis tunnel v

Host Mame/IP Address[:port number] 1P via LAN
Identifier
Tunnel Server
Port
Password
v Interface
Type
Speed (kHz)
~ JTAG Scan Chain

SWD v
4000 v

< >
Revert

Appl
Filter matched 9 of 11 items PPy

@

Close

RA, RZ, DA,

Debugger RE. Synergy

The Terminate and Disconnect buttons in the user interface have been
improved. The Terminate button will stop the device.

The disconnect button will leave the device in the state defined in the
debug configuration. This has been implemented for the Segger J-link
debugger for ARM based devices.

The "Disconnection Mode" has options for No change, Stop and Continue.

Pressing the Disconnect button will perform the option set in the
Disconnection Mode setting.

<]

Create, manage, and run configurations

€3 [Main]: Program does not exist

BeRX BEY-

[type filter text

Name: | RAtest Debug_Flat |
||| main

Debugger | # Startup| % Source| [C] Common

[€] ¢/C++ Application

[€] C/C++ Remote Application
EASE Script

[©] GDB Hardware Debugging

[ GDB Simulator Debugging (RH:

Debug hardware: J-Link ARM | Target Device: R7TFA2A1AB

GDB Settings Connection Settings Debug Tool Settings

Register initialization No v oA
3 Launch Group Reset on connection No v
v [E7 Renesas GDB Hardware Debug Reset before run Yes ~
[ RAtest Debug_Flat ID Code (Bytes) FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
©7] Renesas Simulator Debugging ( Hold reset during connect Yes v
Reset before download Yes v
Prevent Releasing the Reset of the CM3 Core Yes v
Secure Vector Address
Non-secure Vector Address
Stop ~
~ SWV No change
Core clock (MHz) p
v TrustZone Eontinie
Set TrustZone secure/non-secure boundaries No
v
i< >
eve App
Filter matched 9 of 11 items
? Debug Close

ARM E2

Emulator RA, RZ, DA,
Debug RE, Synergy
Configuration

When using E2 Emulator debugging it is now possible to perform a hot
plug connection to an already running target.
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This is available for selection in the E2 (ARM) debug configuration
settings dialog.

8 Debug Configurations o X
Create, manage, and run configurations ﬁ\
ERRXIEY Name: [ RA_E2 Debug_Flat ]
type filter text || (@ wain 3> Debugger| & Startup| - Source| I Common
[E] ¢/C++ Application
[£1¢/Ce+ Remote Application Debug hardware: |E2 (ARM) ~| Target Device: | R7FAGM3AH
- EASE Script
[£] GDB Hardware Debugging GDB Settings Connection Settings Debug Tool Settings
9 GDB Simulator Debugging (RH8S0) ~ Clock N
# Launch Group Main Clock Source Internal v
~ [ Renesas GDB Hardware Debugging External Clock Input Frequency (MHz)
9 RA_E2 Debug_Flat Permit Clock Source change on writing on-chip Flash Memory Yes v
€9 Renesas Simulator Debugging (RX, RL78) Operating Frequency (MHz)
+ Connection with Target Board
Emulator (Auto)
Type 1TAG v
Speed (kH2) Auto v
+ Power
Power Target From The Emulator (MAX 200mA) Yes v
Power Target via User Interface v
Supply Voltage (V) 33 v
~ Connection
Hold reset during connect Yes v
D Code (Bytes) FEFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF )
Low Power Handling Yes v
Hot Plug No v
~ TrustZone
Set TrustZone secure/non-secure boundaries No
v swv
SWO freauencv division 16 v
Filter matched 9 of 11 items Revers Apply
@ Close

When using Segger J-link debugging it is now possible to perform a hot
plug connection to an already running target.

This is available for selection in the J-link ARM debug configuration
settings dialog.

# Debug Configurations

Create, manage, and run configurations

» Startup
C++ Application
ARM J ||nk 'C++ Remote Application Debug hardware: |J-Link ARM v| Target Device: R7FAZE1AG

RA, RZ, DA,

Debug RE, Synergy

Configuration

FFFFFFFFFFFFFFFFFFFFFFFFFFFFF

ction Mode

Core clock (M

- Ser R Revert
Filter matched 9 of 11 items

DA device support for project import and debugging added for
DA14592/4.

The DA14706 device is now also supported in e? studio.

The SDK for this device can be imported using the File->Import->Dialog
DA support DA SDK Project, Once imported the debug configuration will be migrated to

the Renesas GDB Hardware debugging configuration for Segger J-link.

This will allow RAM and Flash based debugging.
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Dialog SDK
project DA
importer

From e? studio 2023-07, all projects in a Dialog SDK can be imported

using the "Dialog SDK Project" importer.

Projects will be categorized into different types, and you can change the
setting of each project type or each individual project.

a8

Dialog SDK Project

Select toolchain and target device

type filter text

Project Toolchain
v Application
pxp_reporter (C:\Workspace\Dialog\DA GNU ARM Embedded
uartboot (C:\Workspace\Dialog\DA146! GNU ARM Embedded
A4 Host Application
cli_programmer (C:\Workspace\Dialog\| MinGW
libprogrammer (C:\Workspace\Dialog\L MinGW
v Utility
python_scripts (C:\Workspace\Dialog\D Not required

Toolchain version Device

7.3.1.20180622  DA14695
7.3.1.20180622  DA14695

8.1.0
8.1.0

Not required

Not required
Not required

Not required

Project types settings...

Cancel

Host project

When using the Dialog SDK importer there are some projects delivered
which are for building on the host platform with minGW.

build DA Now these projects can be imported as part of the Dialog SDK Import
procedure. These can then be built using an integrated minGW toolchain
in e? studio.
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5. Useful workarounds and information for 2023-07

Please visit the Renesas FAQ for €2 studio for the latest up to date information:
Online FAQ link.

ID Component Workaround or information
Application When using the check for updates feature within e? studio and updating from
7.0.x to 7.1.x the initial restart after the update fails. An error message is
displayed. Subsequent launches of e? studio work without issue.

This is caused by the update to Java.

SH support The Renesas SH device family is no longer supported in €2 studio.

If you need to use the SH device support, please use e? studio 5.4 or earlier.

Importing old All projects being migrated into the latest e studio from e? studio 5.4 and
projects into earlier versions will need to be migrated to the new builder plugins. The new
6.x builder plugins have different user interface pages and different option IDs.

Upon opening an older workspace, the following dialog would be displayed:

P Older Workspace Version

Workspace '/C:/Users/b3800109/e2_studio/workspace54/" was written with an older
version of the product and will be updated. Updating the workspace can make it
incompatible with older versions of the product.

Are you sure you want to continue with this workspace?

Clicking OK will update the workspace to the newer e? studio.

[C] Do not warn again about workspace versions

Importing an existing project to the workspace or opening a workspace with old
projects will automatically start the legacy project upgrade procedure.

If for some reason this process does not start it is also possible to launch the
“Upgrade Legacy of e2 studio Projects...” from the project context menu.

P9 workspaceS4 - C/C++ - € studio

File Edit Source Refacter MNavigate Search Project RenesasViews Run  Window Help

45 Debug 7 CCRX_54 Project HardwareDebug L

[ Project Explorer 53 Bg ¥= 0

% CCRX_54_Project [Hardwa-~N~he~1
New >

Rename... F2

Import...
Export..

= B E

Upgrade Legacy €2 studio Projects...

Build Project
Clean Project
Refresh Fs
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The automatic system pops up a message bubble in the bottom left of the €2
studio application window.

Project Upgrade Required -

Projects in this workspace require upgrading before they can build,
Click here to upgrade these projects,

Ignore

“Smart Browser Notification Startup =

After selecting the menu item or clicking the bubble the following dialog will be
shown:

Upgrade Legacy e2 studio Projects

€3 You must select at least 1 project

(] EI?CCRX_S!-‘I_iject [HardwareDebug]

@' Finish Cancel

To upgrade the project, click the corresponding check box and then click
Finish. Note, this will update the project to the latest build plugins and options.
Before doing this, you should ensure your project is backed up as this
operation is not reversible.

It is possible to upgrade multiple projects in a single operation.
For the GCC toolchains for RX, RL78 and GNUARM-NONE have been made
to the build options which mean we cannot guarantee the same binary output

after upgrade. Please consider this before upgrading.

Another consideration for migration is that debug configurations when opened
in 6.0 will also need to be migrated. The following message will be displayed.
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P Migration needed x

% This launch configuration needs to be updated for the current version of &2 studio
" before it can be used.

Once migrated this configuration will not be usable in older e2 studio versions.

Do you wish to migrate it now?

Yes Mo

Please ensure that your projects are backed up or in revision control before
migration allowing you to return to older versions if required.

Toolchain Before e? studio 6.0 the toolchain management facility automatically upgraded
Management or downgraded the imported project to the latest tools installed on the host
machine.
This no longer happens in the latest e? studio. Instead the toolchain remains
the same and user operation is the only way to change the toolchain version.
This operation is now available within the build settings on the toolchain tab.
An example of CCRX is shown below:
E Properties for CCRX_54_Project
type filter text Settings
Resource
Builders
w C/C++ Build Configuration: |HardwareDebug [ Active ]
Build Variables
Environment
Legging %% Tool Settings Toelchain  Device # Build Steps Build Artifa
Settings
Tool Chain Editor Current Toolchain
C/C++ General Toclchain: Renesas CCRX
Project References Version:  2.06.00
Run/Debug Settings .
Change Toolchain
Toolchain: | Renesas CCRX ~
Version: v2.06.00 ~
If the particular toolchain version does not exist and build is performed, then an
error message is displayed, and the build will fail.
RZ Toolchain The now legacy KPIT GNU ARM-NONE toolchain is still supported within the
e? studio product but now using the gnuarmeclipse plugins.
In addition RZ within e? studio now supports the GNU ARM Launchpad
toolchain. Available from https://launchpad.net/gcc-arm-embedded.
One drawback of this toolchain is that it does not have a standard library
builder provided in the same manner as the legacy KPIT ARM-NONE
toolchain. To use this feature for ARM Launchpad and gain access to the more
efficient optlib libraries a further download is required.
This can be downloaded within the e2 studio installer or directly from here:
https://llvm-gcc-renesas.com/rz/rz-download-toolchains/
Once integrated it is possible to integrate the library generator from the
toolchain tab of the build settings page.
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E Properties for GCC_RZ

type filter text Settings
Resource
Builders
v C/C++ Build Configuration: |HardwareDebug [ Active ]
Build Variables
Environment
Logging 53 Tool Settings & Toolchain ) Device 4 Build Steps Build Artifact E
Settings
Tool Chain Editor Current Teolchain
C/C++ General Toolchain: KPIT GNUARM-NONE-EABI Toolchain

Project References Version:  v16.01

Run/Debug Settings .
Change Toolchain

Toolchain: | KPIT GNUARM-MNOMNE-EABI Toolchain ~
Version: v16.01 ~
Additional Tools

Create Library generator
Create Flash image

See “Create Library generator” option. Once checked the library generator
(libgen) is added to the available tool settings.

QE If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1.
compatibility Other QE series can be used with €2 studio 6.0.
What is QE?

https://www.renesas.com/qe

Details of QE for TCP/IP
https://www.renesas.com/ge-tcpip

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more
handles” this can be caused by certain multi-monitor software and the Eclipse
framework.

If this error occurs there are 2 workarounds:
1. Use a single monitor display.
2. Uninstall the multiple monitor software from your graphics chipset
vendor and revert to the standard Windows multi-monitor feature.

6981 RL78 When debugging IAR C source file with an OCD emulator (E1), the Monitor
Debugging program area (0x00002-0x00003) is used.

Therefore, this area must be excluded from usable address space.
Please add '-HFF' in the linker option.

1. Open Property.

2. Select [C/C++ build]-[Settings] at left side.

3. Select'lAR RL78 Xlink linker" at right side, add '-HFF' at the textbox
‘command".

Not doing this will cause problems with connection and download when using
interrupts.

NA Application If you are experiencing slow building of projects within e? studio there are some
possibilities to improve.

The system environment will attempt to find the make.exe tool via the system
environment. If you ensure the directory, make resides in is at the start of the
path variable it will find it more quickly. Especially important if there are
network drives in the path.
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In the project properties, C/C++ Build tab, behavior tab you can switch on
parallel build. This will take advantage of the multi-cores on your host machine
if it has them.

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01. This
version is no longer supported within e? studio.

KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow
standard ARM naming convention like other GCC toolchain vendors.

The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from
the www.gcc-renesas.com website. The binaries in the 14.01 version are
identical to those used in the 14.01 RZ toolchain.

Once the toolchain is installed your projects will be imported and ported to
ensure there is as little disruption as possible due to this change.

NA KPIT GCC The KPIT toolchains are now no longer supported by the
www.kpitgnutools.com website. Support is now available from the llvm-gcc-
renesas.com website.

In addition, there are two new releases for the GNU toolchains for RX and
RL78. These are now named Renesas GCC for RX and Renesas GCC for
RL78.

Both integrate into e? studio and can be selected from the project wizard.

1922 Application Symptoms: Project fails to build in first instance after archive project import (not
from HEW)

Conditions: If an archived project is imported, it may fail to build the first time,
due to a residual .d file.

Workaround: Clean and Build a second time.

2762 CODAN When using assembly code within a C source file, CODAN errors can be
observed in the editor. Even though the project builds successfully, or even
after rebuild index.

Indexer buffer can be insufficient to process whole project.
Please try giving larger values for the following configurations.

Open preferences dialog through “Window”->" Preferences” menu. In “C/C++” -
> “Indexer” tree, you will indexer configuration as shown below:
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Preferences O X
type filter text Indexer = - -
General
v C/C++ [~ Enable indexer
Appearance Indexer options
Build [ Index source files net included in the build
Code Analysi
oo Analyss [Jindex unused headers
Code Style
Debug [Jindex all header variants
Editor Index all variants of specific headers
File Types |
L ) [[]Index source and header files opened in editor
Language Mappings 2] Allow heurist uti finclud
New C/C+ Project Wiz ow heuristic resolution of includes
Property Pages Settings Skip files larger than: MB
Renesas Skip included files larger thar MEB
Task Tags
Templafe Default Values | Skip all references (Call Hierarchy and Search will not work)
Help []Skip implicit references (e.g. overloaded operators)
AR Embedded Workbench [ skip type and macro references (Search for these references will not work)
lmrsm L] hm A s m

Put larger values for each red-framed variables, then rebuild project or rebuild
index.

2728 GDB Step into does not always work when using the CC-RX 1.02.01 toolchain.
To ensure this behaves correctly you will need to use CC-RX 2.00.00 or
greater as this issue with the debug information is corrected in this release.
NA Eventpoints If eventpoints do not always work just after they are set, you can use the
"Apply to Target" toolbar button in the Eventpoint view to send the Eventpoints
to the target manually. This will always ensure the debugger target has all the
required eventpoint updates before execution starts.
5772 IAR Plugins The IAR Plugin Manager is included in €? studio and provides support for RX,
RL78, RH850 and RZ (ARM).
This tool simplifies installation and configuration of IAR toolchain plugins. You
can access this though Help -> IAR Embedded Workbench plugin manager.
6184 RL78/CC-RL When the load module for RL78/G10 which created at CC-RL is debugged in
debugging E1, please specify the following option:
[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option
7217 Application The restore default settings does not restore all the options set during project
generation. Instead, it sets the defaults to the base settings for the device
family in use.
7524 RZ/T1 In a RZ/T1 RAM-based project, the "Reload" function does not work.
Debugging Reloading or re-downloading during debugging resets the device and the RAM
content is erased.
To continue the debugging, disconnect and connect the debugger again.
Use spaces as Eclipse and CDT both have settings for use spaces as tabs. The option on the
tabs Editor preferences page conflicts with the CDT formatter settings.
To change the use spaces as tabs option in e? studio please use this page:
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Installer In some situations, the AVG virus checker appears to interfere with the e?

problems studio installation process. If you experience such a problem, please
temporarily disable the AVG tool and try the installation again.

Antivirus In some situations, the Norton anti-virus tool can interfere with the building of
Renesas Synergy projects. If possible, please disable the antivirus program
when building Renesas Synergy projects on systems with Norton Antivirus
installed.

Green Hills When debugging the RH850 object built with the Green Hills compiler in &2

RH850 studio, specify the following option for the compiler option:

Projects -gtws

The GUI setting menu is as follows.
[GHS C Compiler for V800 Standalone]-[Debugging Option]
"Generate Target-Walkable Stack" -> On

If this option is not specified, Step Over and Step Return may not work
properly.

17052 Debugging

When debugging using a project with duplicate filenames that are in different
source folders problems can be seen with breakpoint setting.

When a breakpoint is set at a source line in this file it will also stop at the same
source line in the other same named file when execution passes through.

18505 RZ debugging

When debugging with RZ/T1 in certain situations you may experience
problems stepping:

If the following conditions are met:

1. Code is located close to address 0x0
2. There is very little library code included into the project
3. There are unused functions in the program

The possibility arises that the code cannot be debugged. This due to --gc-
sections linker option which removes the unused functions but not the related
debug information.

There are several solutions to this problem:
a. disable --gc-sections until those functions are used
b. remove the unused functions
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RZ GCC Build

In the latest e? studio, the RZ import functionality has been improved.
However, there are still possibilities of older projects causing problems when
imported into e? studio.

In older versions of the RZ build plugins the FPU option was not being handled
correctly. When setting the “Soft” Floating point ABI the command line was still
receiving -mfpu=vfpv3 incorrectly. This can now cause problems with older
start-up code in older RZ projects.

After import if you see an error relating to this please add -mfpu=vfpv3 to the
“Other Assembler Flags” page of the Assembiler tool.

In addition, when migrating some RZ/A1 projects you may experience import
problems unless you build the project in 5.4 first.

RZ DS-5
Project Import

When a DS-5 project is imported into e? studio the environment variables for
Path and TClnstall are copied from the DS-5 environment.

This is not correct. The way to correct this problem is to delete both paths and
replace them with correct values to your toolchain. If you are unsure how to
correct this, please create a new project and copy the values from this to the
converted project.

RX & RL78 When importing a KPIT RL78/RX Library C/C++ project from e? studio 5.4 or
GCC Project before the build artifact settings are not correct.
Import
The output prefix should be set to “lib” but is in fact empty.
RZ/G debug In the case of debugging Linux application for RZ/G, the following error

messages are shown in GDB server console when pushing [Step in] button or
[Step Over] button.

These messages can be ignored because the Step debugging should work
properly even with these messages.

Examples of error messages:

PassthroughTargetCommunication: :sendResponse error 42 46
PassthroughTargetCommunication: :sendResponse error 10 15
PassthroughTargetCommunication: :sendResponse error 42 46

21863 RX&RL78

In previous releases there were some problems with stepping in some

Debugging situations when using the CCRX and CCRL toolchains.
A fix has been made to the debug object converter. To see this improvement
please clean and rebuild the project. The debug information will then be
updated, and the stepping will be more correct and reliable.

Code When using multiple installations of e? studio on your machine you may find

Generator that subsequent installations do not work correctly with the code generator.

registration

The effect is that the code generator cannot be created or added to projects.
Existing projects can be used by the code generator views appear empty.

If this is the case, then the code generator must be manually registered. To do
this execute the following tool:

e.g.
C:\Renesas\e2_studip\eclipse\plugins\com.renesas.cg 2.11.0.v201
80601-1047\CodeGenerator\Tools\register COM.bat
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25278  Synergy When loading Symbols from multiple .elf files compiled using the IAR
debugging toolchain, the user will need to add ".text" before place in FLASH_region
command inside the .icf Script.
e.g.
".text":
place in FLASH region { block LOCK LOOKUP,
ro,
ro section .rodata,
block QSPI NON RETENTIVE INIT BLOCK,
block RAM INIT CODE,
block USB DEV DESC BLK };
25273 RZ Device When changing the device from a RZ/A1 and attempting to swap to a RZ/T1
Migration the device migration is not successful.
The source code is not migrated successfully, and the build fails.
This is due to the different start-up code structure between these devices.
In this case please create a new project and copy the required source to the
newly created project.
25195 RZ/A2M Smart When creating a project of RZ / A2M, the following Warning is displayed in the
Configurator Problems view for the src / renesas / configuration folder.
"Invalid project path: Include path not found"
[Workaround]
Delete the specification of this folder with the compile option include path
setting.
24883 R2/A2M RZ / A2M project generated by e? studio does not support GCC ARM 7.x or
later. Please use GCC ARM 6.3.
27913 GDB server When debugging with an EZ cube, real-time refresh significantly slows down
RL78 debugging features and it makes e? studio look like suspended.
12123  Linker Script The Linker Script Editor may report errors when using some Wild Identifiers
Editor such as 1file.o and *filename.o .
Although these are valid file names and valid identifiers according to the Linker
Script syntax, they need to be quoted when using the Linker Script Editor.
(e.g. "1file.o" and "*filename.o").
RZ/G Linux When using RZ/G Linux Platform Tools, gnu.io.rxtx plug-ins should be installed
Platform Tools same as Nebula plug-ins.
Please follow the below steps to install gnu.io.rxtx plug-ins.
Start the e? studio and select [Help] -> [Install New Software] from the menu
bar to open the [Install] dialog box.
Click on the [Add] button, enter “GNU RXTX Plugin Update Site” as a name
and “http://rxtx.qbang.org/eclipse/” as a location, and click on the [OK] button.
Select [RXTX 2.1-7r4] -> [RXTX End-User Runtime] from the list, click on the
[Next] button, confirm the license, and install the plug-ins.
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32564 MyRenesas

Due to differences in the login data between 7.8 and the 2020-04 e? studio (or
later) version the FreeRTOS download feature does not work in 7.7/8 if the
user has logged into MyRenesas or changed their login data details using
2020-04. If you previously used 7.7/8 prior to using 2020-04 and have not
changed your login details, then both versions will work correctly.

If you need to use MyRenesas in older versions of e? studio after logging in
using 2020-04 then you will need to close all e? studio instances and delete the
file "%USERPROFILE%\.eclipse\org.eclipse.equinox.security\secure_storage". Be
aware that doing this will remove stored passwords for any Eclipse-based
application.

32543 QE

When updating e? studio versions using an installer any installed QE tools are

removed and then must be reinstalled. To preserve QE tools during an update
use the "Check for Updates" function in the "Help" menu to perform an in-place
online update.

30613 RH850

When viewing flash memory in the Memory View, it can be confusing as the
values for this memory type can be random for unwritten blank flash memory
regions.

This can then result in many false positives for memory changes, resulting in
more memory changes than expected. (red text)

To fix this the debugger supports detection and filling of blank addresses areas
with a user specified hex byte value.

There is currently no user interface support for this feature. So, you need to
add the following command parameters to the additional commands section of
the debug configuration. The GDB command line option is: -
uBlankFlaskFill=BB with the blank fill value being 0xBB. Specifying this
value enables the feature, by default it is off.

37443 RA (Linux)

CMSIS Pack Import feature does not work for RA on Linux

36999 RA Deleting the Debug folder from an NS project causes build failure when
reference NSC guard functions.
36007 RA When debugging a secure and non-secure project - the Non-secure callable

functions do not have debug information.
This means you cannot set breakpoints in the secure function.

35767 RA, RZ (Linux)

When importing an image using the "Image" Rendering on Linux Host the
action fails. If you need to import an image on Linux please use the Raw Image
memory rendering instead.

38324 RA

When upgrading an e? studio 2020-04 or 2020-07 containing RA Family
support to 2020-10 or later using the installer you may encounter on the
features page.

To avoid this, you either need to re-select RA on the Device Family selection
page or uncheck and check again "Renesas FSP Smart Configuration Core"
on the Features page.
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[EN Renesas e studio 2020-10 Setup O X

RENESAS

Renesas e” studio 2020-10 Setup

AYA-N3 3IVm-F Y FEERLES.
Renesas e2 studio (20.10.0.R20200923-0905) ~

£37%
FIAR-T73! o

NECEEPS
B IAR Plugin Manager (1.1.0.202007251457)

Java Runtime (11.0.0)

Ll Renesas e2 studic Commen Components (20.10.0.R20200923-0905)

L] Renesas e2 studio Commen Compoenents for ARM Devices (20.10.0.R20200923-0203)
on Renesas e2 studio Tools (20.10.0.R20200923-0905)

qr Renesas RA Family Support (20.10.0.R20200923-0905)

Ll Renesas RZ Family Suppoert (20.10.0.R20200923-0205)

op Renesas RZ Family Suppoert (requiring .Net Framework) (20.10.0.R20200923-0205)

g Renesas RL7& Family Support (20.10.0.R20200923-0905)

Ll Renesas RL7& Family Support (requiring .Net Framework) (20.10.0.R20200923-0905)

FATER(S) | | INTER(D)

Size of install: 244.1 MB

€3 Renesas RA Family Support (20.10.0.R20200923-0905)(Z[ZRenesas e2 studic Commen Compenents
(20.10.0.R20200923-0905), Renesas 2 studio Common Components for ARM Devices
(20.10.0.R20200923-0905), Renesas FSP' Smart Configurator Core (B.2.0v20200922-2032) A1 ETE .

v202009231138 User: All Users

{ VA= Cancel

IDE- RX The Renesas ITRON debug views is only supported with e? studio 32bit
39932 version such as 7.8.0 currently. Enabling the Renesas ITRON debug views on
e? studio 64bit version is under planning.

IDE- RL78

42025 After conversion of legacy GCC projects to LLVM, the generated linker_script

and start.S files should be moved to src folder. "generate” folder needs to be
deleted and the path to the linker script from Settings-> Linker-> Linkerscript
should be change to "${ProjDirPath}/src/linker_script.1ld"

RA When migrating from FSP versions before 3.0 the way pin configuration files
are handled has changed. Previously the projects maintained “.pincfg” files
within the project directory which contained the pin data.

When migrating to FSP 3.0 and the subsequently saving the migrated
configuration.xml the pin data is migrated from these files to the
configuration.xml file.

The “.pincfg” files will still appear in the pin tab until they are subsequently
removed.

IDE- All

44277 From e? studio 2021-07 the RTOS debugging integration has been switched off

by default due to some debug stability problems. This feature can be unstable
with some RA projects. If you wish to switch this back as it may work for you,
you can do so from the debug configuration settings pages. This can be
accessed via the Run->Debug Configurations menu item or via the project
context menu Debug As->Debug Configurations.
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IDE- Symbols of inline assembler instruction could not be resolved on C/CPP

43524 standard language. They can be resolved on Renesas C/CPP Language
Extend. +Renesas C/CPP Language Extends are added in Language
Mappings of new project on e? studio v2021-07. +Renesas C/CPP Language
Extends need to be added manually, if old project is imported to e? studio

v2021-07.
& Properties for Project O X
[ type filter text Language Mapping G B
Resource A R
Builders These settings are project-specific. The mappings listed here override workspace-wide language mappings.
o E:{E:: E::Zral Configuration Content Type Language Add...
Code Analysis (Al C Header File Renesas_C_language_Extend
Documentation (Al C Seurce File Renesas_C_Language_Extend e
File Types (Al C++ Header File Renesas_CPP_Language_Extend
Formatter (Al C++ Source File Renesas_CPP_Language_Extend
Indexer
Language Mappings
MISRA-C In-editor Chet Language settings inherited from the workspace
Paths and Symbols Content Type Language
Preprocessor Include Pz
Project Matures A4
< > 4
‘/?3' Apply and Close Cancel

IDE- RA, Synergy

43405 Microsoft have updated and improved the TraceX tool which can now be
downloaded from the Microsoft Store. If you are using a new version of TraceX
when configuring the tool, ensure you have checked the "Use TraceX installed
from Microsoft Store" option. If you are using an older version, then uncheck
this box. The configuration dialog is available in the preferences dialog.
(Window->Preferences) (Renesas->TraceX category)

IDE- RL78, RX
34814 The CCRX and CCRL build components now support multiple output formats

for Converter tool instead of one format as previous version. If you migrate an
old project to the new e? studio and then return to the old e? studio with the old
output format. You will need to modify the settings as desired.

IDE- RA, RZ

43454
The Linux installer for e? studio cannot be run as root by default, including
using "sudo". If you wish to run it as root, then you need to add "--appimage-
extract-and-run" as the 1st argument. e.g., "sudo ./e2studio_installer-2021-
07.Applmage --appimage-extract-and-run"

IDE- RH850 Synchronous mode is supported in e? studio 2022-01 for debugging RH850

47790 multi-core devices.
There is no need to manually switch between synchronous mode and
asynchronous mode, and the mode automatically switches to the optimum
mode depending on the debug operation.
Basic specifications for mode switching:
When all cores are stopped and [Resume All], the operation mode becomes
synchronous mode.
Resume for one core switches to asynchronous mode and continues in
asynchronous mode until all cores have stopped.
Always use sync mode under the following conditions:
* In that case, the operation of the [Resume] button will be the same as the
operation of the [Resume All] button.

R20UT5328EG0100 Rev.1.00 Page 49 of 61

20th July 2023 RENESAS



e? studio 2023-07 Release Documentation Release Note

-Software breakpoint has been set.
-Connected with a hot plugin connection.
-Connected with a Initial Stop State debugging enabled.

Synchronous mode specifications:

-The [Resume All] button executes all cores.

-When a core is suspended due to a breakpoint or the [Suspend] button, all
cores are suspend.

-For the [Step Into] button, all cores will step in.

-For the [Step Over] button, all cores will be executed. Then, when the
currently active core completes the step over execution, all cores will be
suspend.

-For the [Step Return] button, all cores will be executed. Then, when the
currently active core completes the step return execution, all cores will be
suspend.

Asynchronous mode specifications:

-[Resume] button executes the currently active core.

-Suspend on one core due to a breakpoint or the [Suspend] button does not
affect the behavior of the other cores.

-Unable to set software breakpoints.

Specifications of each button related to execution control:

[Resume] button: Switch to asynchronous mode and run the core currently
being debugged.

[Suspend] button: In asynchronous mode, stop the core currently being
debugged. In synchronous mode, stop all cores.

[Resume all] button: Switch to synchronous mode and run all cores.
[Suspend all] button: Stop all cores and switch to synchronous mode.

Limitations:
-When use Step Into in synchronous mode, cores that are not debugged are
also stepped, but the execution addresses of those cores are not reflected in
the debug view. Check the register view for the correct PC value.

IDE- RX The following BSP packages have been removed from the RX Smart

48013 Configurator:

® 1 bsp gce v1.00.zip
® 1 bsp gce v1.10.zip
® 1 bsp gec v1.20.zip
® 1 bsp gce v1.30.zip
® 1 bsp iar v1.00.zip
® 1 bsp iar v1.10.zip
® 1 bsp iar v1.20.zip
® 1 bsp user vl.10.zip
® 1 bsp user v1.20.zip
® 1 bsp user v1.30.zip
® 1 bsp v3.80.zip

® 1 bsp v3.9l.zip

® 1 bsp v4.00.zip
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® 1 bsp v4.0l.zip
® 1 bsp v5.20.zip
® 1 bsp v5.21.zip
® 1 bsp v5.40.zip
® 1 bsp v5.50.zip
® 1 bsp v5.6l.zip
® 1 bsp v5.62.zip
® 1 bsp v5.63.zip
® 1 bsp v5.64.zip

To continue using the above listed BSP packages, please use the download
function in Smart Configurator to download the exact version.

IDE- GCC Plugins
46896

Projects imported from Windows fail when being built in Linux.

If copying a project with its build output directory between Windows & Linux, or
moving it to a new location, you need to do a clean and rebuild to avoid build
errors.

If storing a project under version control avoid including the build output
directories. At a minimum exclude the *.d files which may contain system
specific paths.

FSP Smart
Configurator

When using the FSP Smart Configurator the linker script is now generated in
the build configuration folder rather than the script folder.

This change should be automatically picked up when the project content is
generated from the FSP Smart Configurator tool. This should ensure that
existing projects continue to work as expected.

When using the IAR toolchain for your project this new behavior can cause
issues. In this case the IAR linker uses the “memory_regions.icf” file available
in the script folder rather than the script file generated in the build
configurations folder. To work around this please delete the file present in the
script folder, then the tool will use the file in the build configuration folder.

IDE- RL78 GCC
55553

The RL78 GCC toolchain has been deprecated in favor of the RL78 LLVM
toolchain. This toolchain offers much better performance and is recommended
for new projects.

IDE- Synergy
59034 Configurator

The Synergy Package view will need to be opened manually from version
2023-01 onwards, as it is not opened by default (since Synergy now uses a
different Pin Configurator than in earlier €2 studio versions). The Synergy
Package view is named "Synergy Package (experimental)".
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(S)gﬂzrggglrator Renesas Synergy no longer supports Synergy Software Platform (SSP)
version 1.x.
Only Synergy Software Platform (SSP) version 2.0 and later will be available
for new Synergy projects. Existing Synergy 1.x projects will prompt to upgrade
upon opening them in the Synergy Configurator, if a later version (2.0 or later)
is available.
This means that it is no longer possible to build SSP 1.x projects in e? studio
2023-01.

Synergy

Configurator

The Pin Editor component for Renesas Synergy projects has been modified to
use the same pin configurator as the RA device family.

Any existing projects that were using the Synergy Pin Editor will have their
projects automatically upgraded upon opening them in the Renesas Synergy
Configurator.

This will allow Synergy users to access the more advanced feature set of the
RA pin configurator and enjoy an updated user experience.

IDE- GreenHills

62045 Plugins for GHS Multi are no longer installed with e? studio. Please see the
GHS Multi manual for instructions on how to install the plugins if you want to
use them.

IDE- Application

61688 Toolbar buttons with functions that are accessible via a menu item have been
hidden by default for new workspaces. You can add them back via Windows ->
Perspective -> Customize Perspective This change will not impact
perspectives in existing workspaces unless the perspective is reset.

IDE- FAA RL78
56105 support For RL78 FAA LLVM project, FAA source level debug is not available. Please

use Disassembly view for FAA debugging.
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6. Linux version
6.1 How to install

For information on how to install the Linux product please refer to FAQ below.

English : https://en-support.renesas.com/knowledgeBase/19934358
Japanese : https://ja-support.renesas.com/knowledgeBase/19934356

6.2 How to run

A. Run ‘terminal’ application of Linux.
B. Move installed directory and Run ‘e?studio’ binary file.

6.3 Register toolchain to e? studio

6.3.1 GNU ARM Embedded
Install the GNU ARM Embedded toolchain to a shared folder as follows:
sudo mkdir -p /opt
cd /opt

sudo tar jxf ~/Downloads/gcc-arm-none-eabi-7-2018-g2-update-linux.tar.bz?2

(assuming the toolchain has been downloaded to your Downloads folder)

On first invocation you will be prompted to specify a workspace location, you will also be advised that there
are no new toolchains available for integration. Open the Renesas Toolchain Management preference page
using the Help — Add Renesas Toolchains menu item, then click on the Add... button and navigate to the root
folder of the GNU ARM Embedded toolchain installation at /opt/gcc-arm-none-eabi-7-2018-g2-update in order
to register the toolchain with e? studio:

Preferences
| (type Filter text @| Renesas Toolchain Management vy
| Toolchain Type Installation Path
Smert Browser
Smart Demo 7.3.1.20180622 éfopt[gccfarm—none—eabif?7201quz—update/ '
b smart Manual KPIT GNUARM-NONE-EABI Toolcha
Support Folders Linaro 64bit
Synergy Configura Renesas CCRX
| Synergy License Linaro
Tracealyzer GCC for Renesas RX
Tracex KPIT GNURX-ELF Toolchain
Task Tags
Template Default Vi
» Help
} Install/Update
| b Java

Library Hover
| P LinkerScript

» MCU
» Oomph Scan... Add... Remove
| @ Cancel Applyand Close
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6.3.2 Linaro
A. Download and extract a toolchain package file to arbitrary directory.
B. Run ‘e? studio’ and select ‘Help — Add Renesas Toolchains’

C. Select ‘Toolchain Type’ and ‘Add’ Location of toolchain.

Preferences

[type Filter text €| Renesas Toolchain Management o v
JS—
Toolchain Type Installation Path
Task Tags GCC ARM Embeddec
Template Default Ve KPIT GNUARM-NONI
» Help Linaro
} Install/Update
b Java
} LinkerScript
» MCU Scan... /1 Add... J Remove
@ | Cancel J ‘Apply and Closef

®

Integrate a new toolchain which is not already registered.

Found: Linaro -7.3.1.20180425

4 frsoftgi linaro7.z | »

Name

[}
= - size Modified
Location: | fhome/softgi/linara7.2 _

i@ arm-inux-gnueabihf 1368
& bin 13 68
i@ gec-linaro-7.3.1-2018.05-x86_64_ar... 3078
W include 1368
i lib 1368
i libexec 1368

@ Cancel
= & share 13 68

] gec-linaro-7.3.1-2018.05-linux-mani... 11.3kB 13 68

2E i@ a«0REBD

Figure 2. Register Toolchain: Browse toolchain location

D. Click checkbox of added toolchain and restart e? studio.

Preferences

|' type Filter text q‘| Renesas Toolchain Management o vw
J——
Toolchain Type Installation Path
Task Tags GCC ARM Embeddec
Template Default V: KPIT GNUARM-NONE
» Help b4 iDaLo
» Install/Update T.E 1.20180425  /home/softgi/linaro7.2/
b Java
» LinkerScript
» McU Scan... J1 Add... J1 Remove

Figure 3. Register Toolchain: ex) Linaro
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6.4 How to build and debug RA applications Overview

6.4.1 Build
Open the New project wizard and choose an RA project.

If this is unavailable it is likely the FSP has not been installed correctly. In this case, quit ¢? studio, reinstall the
pack(s) and restart e? studio again.

Once the wizard completes a sample project will have been created, as well as a debug configuration for
connecting the debugger.

6.4.2 Debug
Once the project has successfully built and produced a build artefact for debug, open the Debug Configurations
dialog and a browse to the Renesas Hardware Debug section.

The debug configuration will match the project name — check that the settings are correct and hit Debug to
connect to the device.

Checks if connection fails.
If the debug connection fails, it is often for one of two reasons:

1. Ifusing a virtual machine, make sure that the device is tied into the VM rather than the host machine.

2. If'the Segger library has not installed as part of the FSP correctly open the
“/home/user/.eclipse/com.renesas.platform_XXXXXXX/DebugComp/RA/ARM/Segger”
folder and copy and paste the 'libjlinkarm.so' into the other Segger folders - e.g. 'Segger v6.50.1°.
Alternatively, take the latest file from the Segger Tools installation folder and install it in the same
place.
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6.5

How to build and debug RZ Linux application Overview

e? studio for Linux supports building and debugging Linux applications for devices of RZ/A Group and RZ/G
Group. For debugging by GDB (the GNU Project Debugger), please add Linux programs gdb-server program to
Linux file system of devices and run as background process automatically. (ssh-server, tcf-agent will be needed for
connection between host system and target device.) For detail about building Linux image for RZ family devices,
refer to embedded Linux wiki pages (https://elinux.org) or Renesas Rulz web pages about RZ family
(https://community.renesas.com/). Descriptions in below is based on RZ/A1H case.

6.5.1 How to add gdb-server to RZ/A Linux root file system

A. Build root file system of RZ/A1 Linux-4.9 BSP.

(path example: ~/rza linux-4.9 bsp/,command example: ./build.sh buildroot)
B. Move to ‘buildroot-***’ directory in ‘output’.

(path example : ~/rza linux-4.9 bsp/output/buildroot-2017.02)
C. Run menuconfig (make menuconfig) and add gdb-server.

(Select ‘Toolchain—Copy gdb server to the Target’ menu)

softgi@softgi-dynabook-RZ83-VB: ~/RZA_linux_4_3/rza_linux-4.9_bspfoutput/buildroot-2017.02

File Edit View Search Terminal Help
fhome /softgi/RZA_linux_4_9/rza_linux-4.9_bsp/output/buildroot-2017.62/.config - Buildroot 2017.02.10-g2e1365e Configuration
>Toolchath —M@¥@™—MmMmX¥838Q MMM —-——M¥ —MM¥X™M¥ —M8¥ M¥X™M¥X8Q —M¥X M M MMM MM M M MM M M M M M M
Toolchain
Arrow keys navigate the menu. <Enter> selects submenus ---> (or empty submenus ----). Highlighted letters are
hotkeys. Pressing <Y> selects a feature, while <N> excludes a feature. Press <Esc><Esc> to exit, <?> for Help, </>
for Search. Legend: [*] feature is selected [ ] feature is excluded

Toolchain type (External toolchain) --->
*** Toolchain External Options ***
Toolchain (Linaro ARM 2017.08) --->

Toolchain origin (Toolchain to be downloaded and installed)
) copy g server to-the Tarzed
*** Host GDB Options ***
*** Toolchain Generic Options ***
[ 1 copy gconv libraries
[*] Enable MMU support
() Target optimizations
() Target linker options
[ ] Register toolchain within Eclipse Buildroot plug-in

< Exit > < Help > < Save > < Load >

Figure 4. Menuconfig: set ‘copy gdb server to the target’

D. Move to ‘target’ directory in ‘output’ of ‘buildroot-****’,
(path example: ~/rza linux-4.9 bsp/output/buildroot-2017.02/output/target)

E. Add new file with a line as command at ‘/etc/init.d’ directory

File name: S5lgdbserver

Command: /usr/bin/gdbserver --multi --remote-debug /dev/ttySCO

F. Delete or disable below contents from etc/inittab.

# Put a getty on the serial port

# ttySCO::respawn:/sbin/getty -L ttySCO 115200 vt100 # GENERIC_ SERIAL

G. Move ‘Linux-4.9 BSP root’ (path example: ~/rza_linux-4.9 bsp/) and build root file system again. Download
root file system at target device.
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6.5.2 Linux C/C++ Project generation and build

A. Connect target device which is run as Linux, via Serial port.

C. After editing codes, build by selecting ‘Build Project’ in right-click menu or push

B. Select ‘File — New - RZ Linux C/C++ project’ menu and make new RZ/A1H Linux C/C++ project. In phase

of ‘RZ Linux connection settings’, the serial port which is used for connecting target device, will be selected
automatically.

RZ Linux Project e RZ Linux Project x

RZ Linux toolchain and project selection — RZ Linux connection settings —

[ Select connection details

Select target device, toolchain and a template project

RZ Linux Target Device RZ/ATH (R75721000) - Connections
Toolchains Linaro - Useserial Port: |[EEWIE v | wdrate: | 115200
Toolchain Version 7.3.1.20180425 - | /deuftiyacio |

2.162.222 - New connection

Network: | 172.22

Project templates

RZ/A1H Hello World C++ Project
est Project for RZ/ATH device

Open Network Connections

® <Back Next > Cancel Finish ® < Back Next > Cancel Finish

Figure 5. New RZ Linux project & connection setting: Serial port

button.
workspace - RZA_Linux_App/src/Hello.cpp - e2 studio

Run Window Help

| 4§ Debug {7 RZA Linux_App_rza B2 ® ~ | ~ 5| _# New Connection... R B v iEiwit -
& Project Explorer R E% =08 | g Hello.cpp 2
68 e } else {
69 system("echo © > /sys/devices/leds.1/leds/led3/brightnes
70 }
7
ndow 72 result = functione3(arg);
73
74 return result;
75 }
76
77 =int function@3(int arg)
78 {
Source 79 unsigned long result = 6;
80 calle3++;
. 81
Rename... 82 std::cout << “function®3:" << calle3 << std::endl;
83 = if (calle3%ze > 18) {
84 system("echo 255 > /sys/devices/leds.1/leds/led4/brightr
85 = } else {
86 system("echo ® > /sys/devices/leds.1/leds/led4/brightnes
87 }
88
89 result = functione4d(arg);
90
91 return result;
92 ¥
93
94 =int function@4(int arg)
95 I

Figure 6. Build Project
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6.5.3

GDB debug by using serial port communication

A. Terminate all processes use serial port communication such as Minicom.
B. Open ‘Configuration’ and check ‘Serial’ is selected as ‘Connection’.
i = L Edit configuration RZA_Linux_App_rza for Debug
3% Debug % RZA_Linux_App_rza D il 5
— Launch Configuration Name: | RZA_Linux_App_rza
({1 Project Explorer 52 =% =08 || ¢ Hello.cpp &2
o o ~ | B Main| &» Source | [0 Common | Debugger | ¢9: Arguments
. < 68
¥ 4 Binaries ?g Project:
b @includes I{ RZA_Linux_App | Browse...
» =Debug 1; S R
¥ = srC %4 C/C++ Application:
» [ Hello.cpp 75 } | | Debug/RZA Linux App.elf
[ERzA_Linux_App_rza.launch %? i Variables... Search Project... Browse...
Zg { Build (if required) before launching
2? Build Configuration: | Select Automatically -
g § Enable auto build Disable auto build
84 O Use workspace settings Configure Workspace Settings...
85 @
86 Connection
87 .
zg Serial Port: | /devfttyACMO  ~ | Baud rate: | 115200 -
98 S
91 rneclion - Edit Pron
92 } onnectic LOCa v NEW Eqit Fre
93
94 =i1| Remote Absolute File Path for C/C++ Application:
3; i ftemp/RZA_Linux_App.elf | Browse...
2; Commands to execute before application
99
100 Skip download to target path.
181
102 Attach Only
183
104 }
(22 Problems ¥ Task;
= A
CDT Build Console [RZ4 @ Cancel OK
Invokina: Cross ARM ___
Figure 7. Connection configuration: Serial
C. Run debug by push button - . It takes 10 or more seconds for transferring binary files to target device.
Pop up message for switching to debug perspective will be shown after transferring binary files.
workspace - RZA_Linux_App/src/Hello.cpp - e? studio
[ RzZA_Linux_App_rza
Ity Project Explorer 2 B% ¥=18 || [ Hello.cpp =
i 68 8 } else { ) .
b 4 Binaries 23 X system("echo 0 > /sys/devices/leds.1/leds/led3/brightness"};
» &l Includes 71
» = Debug 72 result = function@3(arg);
¥ Esrc return result;
¥ [¢ Hello.cpp }
= core : n :
) ~int functione3(int arg)
E RZA_Linux_App_rza.launch
— This kind of launch is configured to open the Debug perspective whenit

L @ suspends.

E This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?
} Remember my decision
5 No Yes
eij
4 e -
Figure 8. Debug: Perspective Switch
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D. ‘Debug Perspective’ provide ways for flow controls and configurations.

workspace - RZA_Linux_App/src/Hello.cpp - e? studio
e

4% Debug [ RZA_Linux_App_rza g ® ~ & ~ @ & New Connection... MR SR gl=ta 1 3

& v % BLiFDH
45 Debug 12 %124 ¥ =05 [w-variables X % Breakpoints i Registers = Modules &7 Expressions
w[EIRZA_Linux_App_rza [Renesas Linux Application]
~ [ RzZA_Linux_App.elf [467] [cores: 0] Name Type Value
~ * Thread #1 467 [core: 0] (Suspended : Breakpoint) @:tmp unsigned long 1
main() at Hello.cpp:36 0x107dc

s arm-linux-gnueabihf-gdb (7.8.2)

[© Hello.cpp =0 |5 outli

25 08010756 calle2 = E; + fu
26 0001075¢ callod = o; & Fu
27 ©001076C total result = 0; .
28 - & co
29 & while(1) { ® ca
30 00010772 counter++; ® ca
31 000108792 = if (counter >= 0x1000000) {
32 800107a2 std:icout << "Hello World!" << std::endl; ® a
33 000107¢c6 counter = 0; ® ca
;j 009107d4 tmps+; ° to
36 989107dc total result = functiond [ o m
Expression Value Address e fu
unsigned long Oxbefffd34 e fu
Toggle Software Breakpoint e fu
e fu

Toggle Ha
mption (QE) - Performance Analysis 3 v

: tmp
Details:1
Default:1
Decimal:1
Hex:@x1
Binary:1l
Octal:e1
Build Selected File(s)

Figure 9. Debug: Control buttons, views, setting break point
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7. Open Issues in 2023-07

Open issues in the e? studio 2023-07 product will be kept up to date here:

Please visit to see the latest open issue list.
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8. Appendix
8.1 Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

8.2 Web Access and Privacy Policy

Collection of User Information Applications included in this package may access the Renesas Web site. In such cases,
the following information is collected and recorded to Renesas server as a log.

* Date and time of access
* Access to URLs and files
* The unique certificate number linked to your account for MyRenesas (only when you log in to MyRenesas)

* The unique identification number linked to cookies for the Web browser (for cookies, refer to the privacy policy page
stated below).

Logs are managed based on our privacy policy.
Refer to our privacy policy on the following Web page.
Privacy Policy:

https://www.renesas.com/privacy.html
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All trademarks and registered trademarks are the property of their respective owners.

“FreeRTOS™ js the trademark of Amazon Web Services, Inc.
AWS™ Amazon Web Services™ is the trademark of Amazon Web Services, Inc.”

GITHUB® is the trademark registered in the United States by GitHub, Inc.
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1.

(Notel)
(Note2)

Corporate Headquarters

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and
application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or
system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software,
or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other
intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including
but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture,
sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability
for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas
Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic

appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial
terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics
document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury
(artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power
control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses
incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual
or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or
software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any
unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT
WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS
PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR
OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY
ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW,
RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY
RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and
Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect
to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any
malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics,
such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh
environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design.
You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in
the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software
alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product.
You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including
without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics
disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under
any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by
the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the
product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.
“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
WWW.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2023 Renesas Electronics Corporation. All rights reserved.
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